Provider Portal User Guide

Version 6.8

October 30, 2023




Table of Contents

DOCUMENT OVEIVIEW ...t s 6
Purpose of this DOCUMENT .....ccciiiiie i, 6
INEENAEA AUGIENCE .ttt et e e e e e e s bbbttt e e e e e s s abbbtateeeeeesannbbaeeeeaaeens 6
What's New in this USer GUILE?.....ccciieiiiiiiiiiiiiee ettt ettt ettt e e e e e e st re et e e e e s s anereeeas 6
LY ] 7= [0l O SO U SO P U PP UPUPPPPPUPPPPPP 6

ACCESSING the Provider POItal .......eiiiiiiiiiiiiiiiiiiiieeeeee ettt ee e eeeeeeseeeeeesesesesaseseesesssesssessesssssessnennnns 7

Creating a Provider Portal ACCOUNT ......cooii i, 7

Troubleshooting a Provider Portal ACCOUNT Error IMESSAZE ....uuuuuuuuuuuuiice e 12

Creating a Provider Portal Account for Ownership Change .........ccccc 13
Indicating a Change / Transfer in OWNEISRIP........coicuviiiiiiiiee et eeree et estre e e e eeraeeeeeareee s 13

Selecting the Site of Ownership Change / Transfer.......cocvviiiiiiiei et 13
Ownership Change / Transfer QUESTIONS ..........veieiiiuieieeiieeeeecieee e eetreeeeeereeeeeebreeeeetreeeeenebaeeeenasees 16
DOCUMENT UPIOA. .. ueiiiiiiiiiiiiiiitt s 16

Provider Portal REEUINING USEI ......uuuuueiiiiiiieiii s 18
oY= o] o T o o ol LT PR P PTPPTPPPRRRRPPRt 18
PasSWOId RECOVEIY....ccc i, 18
Change PasSWOIT PrOCESS. ......uuuuuuuueueeeueeiiiuiiitt s aannnnnnnnnnnnnnnnnnnnnnnnn 20

Provider DAashDOArd........cc.uueiiiiiiiieie ettt e s st e s sttt e et e s s e e s aneeee s 22
Update Provider Portal User Account Information..........ccccooi 23
MUIIPIE SIEES e 24
Y T aF TN (=L PP PPPPRRPPR 24

Adding a Site for a Physical Location Change.........uuiiiiiiiiiiiiiiiiiiieiiiiiiieiereeressseesseereseessesserrerrrrr—... 27
Y T aF T =T U L] =T PSP 29
Yo Lo [T g Y- T LY =T P PPPPPPPPPRt 31
Adding a Business Administrator to MUItiple SIteS .........uuiiiiiiiiiiiiiiiiiiiiiiiiiiiieeeeeeeeeeeee e 34
Lo Lot A L g T T Y- PSRNt 36
Provider Cost Of Care ESTIMAte .......ueiiiiiiiiieeiee ettt ettt e e s e e s abeeee s 37
Broadcast Messages (not yet available) ... 42
COalItION IMIESSAZES .. uuuuuuuuueuuueeiiuetiuttttt e aaaaaaaaaaaaaaaaaaaaanaaaaaaaannnnnnnnnnnnnnnnnnnnnnnnnnnnnnnnnnnnnnnnnnanaaaaaaaaan 42
FrequeNntly USE LINKS. .. ..o et e e e e ettt s e e e e e e ettt e s e e e e e e easnaeeeeeeseeennnannns 43



Completing the Provider Profile........o 43

REGUEST ASSISTANCE .ceiiiiiiieee ettt e e e ettt et e e e e e eeeeb b e e e e eeeeeanaaeeeeeeeeensnaaens 43
BUSINESS INFOIMAtiON ...t e e et e e e e e s s st e e et e e e e e e s nbrraeeeaeeens 45
Manage External Service Users - Renaissance VPK FAST Star Early Literacy ........cccceveviii, 47
Fi¥e o [T oY= o I Y UL o T T b2=T o I UL =T PP PPPPPPPPRE 48
Associating A User to MUILIple Providers........uuuuuuueeiiiieiiiiiieiiiiieieeeeesieeeeseerereeeeeeeereeer——.. 49
oo T = T 50
DIETING A USBI a.uiiiiiiiiiiiiiiiiiiititittt s 51
PO et e et e st e e s e s aneeee s 52
SEEP 1 — GENEIAN ettt an 54
SEEP 2 = FACHTY . uuuuetetieietiiitt s 55
Public Records EXemption INAiCAtOr.........uuuuuueuuiii s 56
YT I Y= T oV ol T PO UPPRTRUPPPPNN 59
SEEP 4 — CUITICUIUM Loeteeeiie s 60
Y =] o Rl YT R B Yoo 1H ] | £ PSP PPPPPRt 60
Step 6 — HOUIS Of OPEIAtioN .....uueuuueieiii s 61
Step 7 — Staffing & CAPaCity ..uuuuuueeeuiiii s 62
Example: Child Care CENTEI L.......uuuuueieieeiii s 64
EXample: Child Care CENTEI 2.......uueeieie s 64
Example: Family Child Care HOMES L........uuuuuuuuuiiuiiiiii s 65
Example: Family Child Care HOMES 2........uuuuuuuuuiiiiii s 65
Example: Family Child Care HOMES 3........uuuuuuuiiiiii s 66
Example: Family Child Care HOMES 4.........uuuuuunniii s 66
Example: Large Family Child Care HOMES 1 ........uuuuuuuuuu s 67
Example: Large Family Child Care HOMES 2 ........uuuuuueni s 67
STEP 8 — Private Pay Rates...ccuu i et e et e e e e e et e e e e e eaaan 68
StEP 9 — ClOSUIES CalENAAr......ueeeiieieiiiiiiii e nnan 69
=T oI KO To Tl 8 1= o | £ N 70
=T o B R V1= N 71
StEeP 12 — SigN AN COITITY .uuuruiiiiiiiii e nan 72
Managing a Profile as a Provider POrtal USEI ........ ... . e 73
Provider DashbOard.............eeiiiiiiiiee e e e e e e e e e ee e e e e e as 73
Y T aF Teq T = ©o ] o} i - Lot SN 75



MaNAGING DOCUMENTS ...ttt e et ettt e e e e e e eetat e e e e eeeeees e e eeeeeeansnaaannnns 76

Viewing/UpPloading DOCUMENTS.........uviiiiiieeeeeiiteeeeciteeeeestreeeestreeeesabaeeeestraeeessbaseesasseeessnssaesanns 76

F Yol YAV o= 3 o Yol ¥ o 0 [=] ) £ PP PPPPPPPPRE 78
PrOVIAEr CONEIrACING .uvvveeeiiiiiiiiitt s 80
R 2 o] o = o PP P P PPPPPPIRN 80
Provider Eligibility and NOtifiCation ..........uueeieii s 81
Provider Responsibilities and SCOPE OF WOIK........uuuuuuuuuc s 81
Signature AULhOTILY ..o 82
EXNiDit 1: Program ASSESSIMEBNTS. ...uuuuuuuuuuiuuitieiit s 83
EXhibit 1: Child ASSESSMENTS .....eeiiieiiiiiiee ettt e e e s e s snree e e eaneeee s 84
Exhibit 3: Quality Improvement Plan SEleCHiON..........uuuuiu 86
Exhibit 5: Provider Reimbursement RAtes .......coocueiiiiiiiiieiiiiiie e 87
EXhibit 6: HOlIAAy SChEAUIE .......uueeiiiii s 88
PrevieWw CONTIaCt ........uuiiiiiiiiiiiiiii s 89
Contract EXECUTION ... 90
CoNtract CertifiCation........coiueieiiiiiee e et e e 92
VPK CONTIACT e 94
Compensation and Funding: Advance Pay Options..........ccccoiiiiiiiii 95
Exhibit 1: Provider Location List Attachment .........coeiiiiiiiiiiiii e 96
PrevieW CONTIACt .......uueuiiiiiiiiiiii s 96
Contract EXECUTION ...ocooiiiiiiiiii 98
CoNtract Certification.......cooieiiiiiie e e s e e 101
VPK=APP ettt e et e et e e e aa bttt e e e b bt e e e h b e et e e e b be e e e eaa b et e e e e bttt e e eareeeeearraeens 103
Step 1 — Attendance POlIiCY. ... 103
YT P AV o QB ¢ =Y ot o ] PPN 104
T I VA o Q[ ] o U Tl o PPN 105
Step 4 —VPK Calendars ... 106
StEP 5= VPK Class(€S) ceeeieeieeieiieeeee e 110
T oI STl Y=LY= PPN 111
Step 7 — Certify and SubmIit..........ooo 112
VPK-APP for Ownership Change.........ccoooeeiiii i 113
VPK-APP for Location Change ..o 113



Updating @ VPK-APP ..., 114

LV G D11 = o ] PP PP PP PP P PP PP PPPPPPPPPPPPPPPRt 114

VPK INSTFUCTONS ..ttt e e et e e e e et ee e s s e e e e eeennnas 115

VL QO 1 1= g To T T TSP PP PPPTPPPPPTPNt 119

LV Q= =T SRR PRUURN 123
Editing an SR Contract AMENAMENT........uuueeiii s 126
Viewing a Certified SR Contract Amendment ..., 134
Editing @ VPK CoNtract AmMENAMENT. ... ..uuueeeieii s 135
Viewing a Certified VPK Contract AMeNndmMeNnt .........euvviiiiiiiiiiiiiiiiiieiiiieeissesseessrssseerreresseeer. 142
ENFOIIMENTS = VPK .. ettt et e e st e s st e e s e e e e e snre e e e snres 143
RequUESt/Change ENFOIMENT......coicuiiii ettt ere e e e e e e stb e e e e setbeeeesearaeeeesbseeeeeareee s 143
ENrolling @ VPK CHild.......uuuieiiiiiiiiiii s 144
Managing VPK ENTOIIMENT ....uueiiiiii s 147

VPK BUIK ENFOIIMENT PrOCESS ..cnevveeeeieiiee ettt ettt et e st e s s e e s anneee s 155
VPK-20 CoNtract VErfICation .....ceeeeiiiiiiieeeiee ettt e s e e s 160
ENFOIIMENTS = SR ettt ettt e et e s st e e s aab b et e s s e e e saab e et e e snre e e e snreee 161
Pending Family Acceptance Status. ..o 161
Viewing Enrollments in Pending Family ACCEPLaNCe ......uuvviiiiiiiiiiiiiiiiiiiieeieevevvveeeevereeeeeeeeeeeeeeeeeaenes 162
Ending Enrollments in Pending Family ACCEPLaNCe........uuuuuuuuuiccc e 162
Cancelling Enrollments in Pending Family AcCeptance ........ccccccvviiiiiii 164

SR Eligibility REdetermMiNatioNns ............euuuuiiuii s 165
Upcoming Eligibility RedeterminatioNns. ............ s 165

Past Due Eligibility Redeterminations...............uuueuuiueeiecc s 165

B =T8T 0o T =1V 1 (o T U =T 167
Creating a Temporary Closure for a Whole Site CIOSUIE ..........uuuiiiiiiiiicecccecee e 169
Creating a Temporary Closure for all or some SR Care LeVels. .......cccociiiiiiiiiiiiiiiiicciceeeeceeeee e 171
Creating a Temporary Closure for all or Some VPK Classes. .........eiiiiiiiiiiiiiiiieieiieeeece e 175
VPK Non-Reimbursable Temporary CIOSUIES..........ccooeeieiiiiiiee e, 179
Update VPK Class CalENdar..........uuuuuuue s 180
ATEENAANCE ROSTEIS ...eviiiiiieeii ittt e e e e s e e e e e s s s s e e e e e e e e s e snrreeeeeeeesaannnes 183



PN = g Yo =T a Lo S VA o] TN 185

SUBMItEING AttENAANCE ONIINE ...eiiiiii s 185
SUDMITEEA ATEENAANCE ...ttt e e et e e e e s s s e e e e e e e e e s s sanereeees 188
REJECLEA ATEENUANCE ..uvviiiiiiiiieiii s 188
FAY o] o] ge)Y7=Te [N A =T oo -1 Vol PP PPPPPPPRt 189

Uploading Bulk Attendance File ..o 190

ATEENAANCE - SR ...ttt e e s st e et e e e s e e e e e raeee s 193

SUbMIttING AttENAANCE ONIINE ...uuiiiiiiii s 193
SUDMITEEd ATEENUANCE ....ceiiiiiiiiiiiiee ettt e s e s s e e s snreeeenaes 199
REJECLEA ALEENUANCE ...vvvviiiiiiiiiii s 199
F Y] o] ge)V/=Te I\ A =T oo 1 Vol PP PPPPPPPRt 201

Request for Registration FEE PayMENt.........uuuuuuuuuuuiiiiii s 202

DiISIMISS CRITAIEN «..eeeeeeeeeee et e e st e st e e e st e e e sabee e e saaneeee s 203

SR ReimMbUrsement RAte PIan ......c..uiiiiiiiieeeee ettt e s nreee e 205



Document Revision History

Document Version Date Author Revision
6.0 01/26/23 Jim Ledbetter Final
6.1 02/23/23 Jim Ledbetter Final
6.2 04/06/23 Jim Ledbetter Final
6.3 04/27/23 Jim Ledbetter Final
6.4 05/30/23 Jim Ledbetter Final
6.5 06/27/23 Jim Ledbetter Final
6.6 09/26/23 Jim Ledbetter Final
6.8 10/30/23 Jim Ledbetter Final

Document Overview

This document provides a step-by-step guide to navigate the Provider Portal.

Purpose of this Document

The purpose of this document is to provide Provider Portal users with a reference document to successfully
navigate and perform business processes included in Release 6.8 of the Provider Portal.

Intended Audience

The intended audience for this document includes provider staff responsible for completing profiles, contracts,
enrollments, and attendance.

What’s New in this User Guide?

New text and screenshots for Public Records Exemption Indicator.

Assistance

If you have questions about any of the material in this user guide or about any processes not covered by this guide,
please contact your local Early Learning Coalition.



Accessing the Provider Portal

The link to access the Provider Portal is https://providerservices.floridaearlylearning.com.

Creating a Provider Portal Account

First-time Provider Portal users must register for an account to access the Provider Portal. Provider Portal users
with multiple provider sites should begin by registering only one site location. This could be the provider’s primary,
flagship, or main location. Once a Provider Portal account registration request is approved for one provider site,
the provider user will be able to create accounts for additional sites after logging on to the Provider Portal.

Provider Services Logon

Account Information

User name (must be a valid email address)

Not yet registered?

Click here to register a new provider account.

Password

Forgot my password

Change my password

Click the here link to start the new account registration process and the following page will display:

A Provider Portal user must enter the taxpayer identification number (from the provider), the provider
identification number (from the early learning coalition) and the Department of Children and Families (DCF)
license, registration, exemption number or type the word “EXEMPT”. Providers may enter “EXEMPT” if they do not
have an exemption number from DCF.

The Provider Portal user must click the Verify License Details button to complete step 1 of the Provider Portal
account registration process.



https://providerservices.floridaearlylearning.com/

If a match is found for the submitted information, the following message will display:

If the information is not correct, click the No button and contact the local early learning coalition.

If the information is correct, click the Yes button. On the next screen, the registration information will be
populated by the system, with the exception of User Information.

If a match is not found for the provider information, the following message will display:



After filling in the required information (noted with a red asterisk *), the Provider Portal user must click the
Register button to complete the registration process.

Register for a New Provider Account

Already registered?

Click here to log in with your existing account information

License Details

Taxpayer or Provider identification number* €

License/Registration/Exemption number, or EXEMPT* ©

Business Details

Business name associated with your taxpayer identification number*
Owner/Operator name™

Principal Address line 1%

Principal Address line 2

Principal City *

Principal State ®

Principal Zip code ®

User Information

First name *

Middle name

Last name*

Account user name (must be a valid email address)“"
Confirm account user name *

Password (must contain at least 8 characters)™

The password must use at least three of the four available character types
~ must be at least 8 characters long,

= lowercase letters (a through z),

* uppercase letters (A through Z),

* numbers (0 through 9), and

* special characters(! #8% * & +=2~-_[}[]1/.]::)

Confirm password *



Location Details

[ Redlands Christian Migrant Association (RCMA) Provider €9

Doing Business As name (DBA)*

Provider type®

Legal status*

Contact person phone number ™

Physical Address of Facility

(O Facility address is the same as principal address

Address line 1%

Address line 2

city*

State

Florida

Zip code®

County of physical location™

--please select a value—

Is this site being created due to a change/transfer of Ownership?*

O Yes O No
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After clicking the Register button, the following message may display:

Click the Select this radio button to accept the standardized United States Postal Service (USPS) address or the
Entered Address if the USPS Address is not found. Then, click the Apply button to continue. If the Provider Portal
user clicks the Close button, the user will be taken back to the previous screen to re-enter the address information.

Once the Provider Portal user submits an account request, the following page will display:

Account Request Confirmation

Your registration/activation request was sent to an administrator for processing. You will receive an email when your account is approved.

Please click Continue to proceed to the logon page.

The Provider Portal user should access the email address used in the account and find the email sent by
DONOTREPLY@oel.myflorida.com.

Hello Jim Ledbetier,

You are receiving this email because somecne registered this email address for an account in Florida's statewide early leaming Provider Portal. You will receive an email that will notify you how to proceed after your request is processed by
your local early learning coalition

ELC of the Big Bend Region

(866) 973-9030
http:/iwww elcbigbend orgf

Please do not reply to this message. Replies to this message are routed to an unmonitored mailbox. If you have any questions, please contact your Early
Learning Coalition at the number listed above.

If the registration request is approved, the following email will be sent by DONOTREPLY @oel.myflorida.com.

Hello Jim Ledbetter,
The Provider Portal registration request you submitted for Jim's House of Learnin’ 2 has been approved. You may now log on to the Provider Portal with the user name and password you registered with.
ELC of the Big Bend Region

(B66) 973-9030
httpe/iwww. elebighend orgl

Please do not reply to this message. Replies to this message are routed to an unmonitored mailbox. If you have any questions, please contact your Early
Learning Coalition at the number listed above.
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The Provider Portal user can log on to the Provider Portal at https://providerservices.floridaearlylearning.com.

Troubleshooting a Provider Portal Account Error Message

If the Provider Portal user receives the following message, contact the local early learning coalition to verify that
the taxpayer identification number matches the DEL database.

The license number belongs to a provider/business that is associated with a different taxpayer identification number.

If the Provider Portal user receives either of the following messages, contact the local early learning coalition to
determine if a provider portal account has already been created.

The license number belongs to a provider that is already associated with a registered account.
The taxpayer or provider identification number belongs to a business that is already associated with a registered account.

If the Provider Portal user receives the following message, contact the local early learning coalition to determine if
the user name (email address) has been used in the Family Portal. The coalition may need to consult with DEL to
make this determination. If a user name has been used in the Family Portal, even if an application was not created,
DEL will have to remove the user name from the database so it can be used in the Provider Portal. If a provider has
improperly used a user name to complete SR or VPK applications for a parent, the provider must contact that
parent to get a replacement user name for that application so the provider’s user name can be used in the
Provider Portal. Another option is for the provider to pick another user name to use in the Provider Portal.

Account user name (must be a valid email address) *

oeldemonstration+pb@gmail.com

User name "oeldemonstration+pb@gmail.com" is not available.

12
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Creating a Provider Portal Account for Ownership Change

Indicating a Change / Transfer in Ownership

If a new Provider Portal Account is needed due to a change in ownership of an existing provider site, select Yes for
the question Is this site being created due to a change/transfer of Ownership?

This question is in the “Physical Address of Facility” section, under “County of physical location”.

Physical Address of Facility

O Facility address is the same as principal address

Address line 1%
Address line 2
city*

State

Florida

Zip code™

County of physical location*

—please select a value— v

Is this site being created due to a changeitransfer of Ownership?*

@ Yes O No

Selecting the Site of Ownership Change / Transfer
After selecting Yes, an address lookup will display. This lookup will search for the Provider site under new
ownership.

This site is being created due fo a change/transfer of Ownership

Old / Previous Site Address prior to Ownership Transfer

Please type the physical facility address of the Provider location, of the site which changed ownership
[ same as current?

Address Line 1

Address Line 2

City

State

Zip code

To search for the Provider site under new ownership, enter the Physical Address of Facility information in the
appropriate address fields. Alternatively, if the address of the facility has not changed and the “Physical Address of

13



Facility” section has been completed, the Same as current? checkbox can be selected in the upper left-hand corner
of the lookup.

J Facility address is the same as principal address.
Address ling 1%
Address 1
Address line 2
Address 2
City™
City
State
Florida
Zip code™®
32304

County of physical location™

BEroward

This site is being created due to a changetransfer of Ownership

Qld !/ Previous Site Address prior to Ownership Transfer

Please type the physical facility address of the Provider location, of the site which changed ownership
Same as current?

Address Line 1

Address 1
Address Line 2

Address 2
City

City

Tk

TIP: If the Provider Site under new ownership cannot be found through the lookup, eliminate specific street
numbers and Apt/unit/suite numbers and re-run the search.
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Once the correct site is located, select the site in the list of “Possible Matches.”
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Ownership Change / Transfer Questions

Once a Provider site is selected in the lookup, two questions will display regarding the change/transfer of
ownership. For each question, indicate whether the statement is true, by selecting “Yes,” or false, by selecting
“NO."

If you are unsure about how to answer these questions, please see Rule 6M- 8.301 (8) F.A.C.

Document Upload
The document upload section is for documents pertaining to the change/transfer of ownership.

Appropriate documents include, but are not limited to:

- abill of Bill of Sale of the transaction where the business was sold or transferred
- documentation showing consideration paid for sale or transfer
- and written statements from the owner stating that they have no previous interest in the business.

Additional documentation types may be dependent on the coalition’s discretion.
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Flease answer the following guestions regarding your fransfer/change of ownership:

Do you have any family relationship te the owner of the previous site?
() Wes @ Mo
Did you have a preexisting ownership interest in the business prior to the transfer/change of ownership?

@ Yes () Mo

Document upload: Please upload documents conceming your change in Cwmership
(Examples include Bill of Sale, interest in ownership documents, consideration for sale documents, efc)

test doc 1.doex 11.95 KB @Cance
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Provider Portal Returning User

Log on Process

Provider Portal users who have already created a user account can log on from the Provider Services welcome
page by entering the user name and password created during the account process. Click the Log On button to
continue.

Provider Services Logon

Account Information

User name (must be a valid email address) Not yet registered?

Enter User Name . . .
Ent Click here to register a new provider account.

Password

Forgot my password

Change my password

Password Recovery
If the Provider Portal user cannot remember the password, the user can click the Forgot my password link.

Provider Services Logon

Account Information

User name (must be a valid email address) Not yet registered?

Enter User Name Click here to register a new provider account.

Password

Forgot my password

Change my password

Clicking the Forgot my password link will display the following page:

Forgot Password Confirmation

If an account was found with the username/email provided, you will receive a password reset link to the
email.

Please click Continue to proceed to the login page
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The Provider Portal user must know the email address used for the account. Once the Provider Portal user enters
an email address and clicks the Continue button, the following page will display:

Forgot Password Confirmation

If an account was found with the username/email provided, you will receive a password reset link to the email.

Please click Continue to proceed to the login page

The Provider Portal user should then access the email account used for the account and find the email sent by
DONOTREPLY@oel.myflorida.com.

DONOTREPLY @cel.myflorida.com 5:14 PM (0 minutes ago) - -
to me |~

You are receiving this message because you or someone else from this email address requested a new Provider Portal password
Please disregard this email if you did not request a new password.

To reset your password you must complete the following steps

1. Please reset your password by clicking here
2. Enter your user name — it must be tl
3. Enter in your new password.

4. Confirm your new password.

5. Click the Reset Password button. A Reset Password Confirmation screen will display if the logon was successful

6. Click the Continue button. The Provider Services Logon page displays and you are now ready to sign in with the new password.

wddress you registered for a provider account with

Please do not reply to this message. Replies to this message are routed to an unmonitored mailbox. If you have any questions,
please contact your Early Learning Coalition at the number listed above.

Once the Provider Portal user clicks the here link, the following page will display:

Reset Your Password

Account Information

Please type the user name and new password for your account, and then click Reset Password.
User name
Enter User Name
Password (must contain at least 8 characters)
Enter Password
Confirm password

Enter Password

| Reset Password ’
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The Provider Portal user must enter the user name (email address), new password and confirm the new password.
After entering the required fields, click the Reset Password button to continue.

If the Provider Portal user successfully changes the password, the following page will display:

Reset Password Confirmation

The password for your account was successfully reset.

Please click Continue to proceed to the login page.

Change Password Process
A Provider Portal user can change the password at any point by clicking the Change my password link.

Provider Services Logon

Account Information

User name (must be a valid email address) Not yet registered?

‘ [Enter User Name

Click here to register a new provider account.

Password

Forgot my password

Change my password

20



Clicking the Change my password link will display the following page:

Change Password

Use the form below to change your password

Account Information

User name

Enter User Name

Current password

New password (must be at least 8 characters)

The password must use at least three of the four available character types:
* must be at least 8 characters long,

* lowercase letters (a through z),

* uppercase letters (A through Z),

* numbers (0 through 9), and

* special characters(! #$ % ~&+=?~-_{}[1/.]::)

Confirm new password

Confirm New Password

Change Password

The Provider Portal user must enter the User Name (email address), current password, new password and confirm
the new password. After entering the required fields, click the Change Password button to continue.

If the Provider Portal user successfully changes the password, the following page will display:

Password Change Completed

The password for your account was successfully changed.

Please click Continue to proceed to the login page.
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Provider Dashboard
After logging on to the Provider Portal, the following page will display:

______________________________________________________________________________________________________________________

ﬁ Home Business ~ Profile - Contracts - Enrollments - Attendance - Documents -

Profile; 2023-2024 ~  Helios GrLogorf 3 @

SoRAES eSS Costion Messagss

Manage Sites

No notifications or alerts to display.
IManage All Sites

Manage Users

IManage All Users

Manage VPK Applications and Contracts
VPK Provider Application

IManage VPK Instructors, Calendars, and Classes
Statewide VPK Provider Contract

VPK Contract Amendment Provider Site Summary Frequently-Used Links

Manage SR Contracts [y
) Business name: Sara's Test Daycare Center Bright Beginnings

Statewide SR Provider Contract

SR Contract Amendment Doing business as: Sara Test Daycare West Core Competencies (Coming Scon)
Provider ID: 24788 DCF Provider Training

Provider Cost of Care Estimate License number: Provider Portal User Guide

+ 2022 -2023 Provider Cost of Care Estimate SSN / Federal ID number: Quality Performance System (QPS)
Accountability ID: A175447 VPK Provider Readiness Rate Website

Preschool Development

In? i} ntal Scresninag Cuieie

NOTE: Effective June 27t 2023, a new number called the Accountability ID will be listed in your Provider Site
Summary. This number is associated with your Provider ID and is displayed for informational purposes.
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Update Provider Portal User Account Information

Provider Portal users can update their user information — name and phone number — associated with their email
address. If the name associated with an email address is blank, the user can add the first and last name. If a name
associated with a standardized email address (e.g. Info@JimsHouseofSmarties.com) needs to be changed due to a
director or other staff leaving, the first and last name can be changed as long as another user has access to that
Provider Portal account. If no one has access to the Provider Portal account, contact your local early learning
coalition to submit a ticket to the DEL Service Desk.

Click on the gear icon.

The following will display. Click the Account Information button.

Enter the additional information and click Save.

L Update User Account Information

Please update your account details to continue

First Name™* Jim

Middle Name Enter Middle Name

Last Name™ Ledbetter

Suffix v
Phone Number* (850) T17-8607

Cancel Save

23


mailto:Info@JimsHouseofSmarties.com

Multiple Sites

If the Provider Portal user registered a provider site that shares a taxpayer identification number with multiple
sites, all of the sites with a shared taxpayer identification number will appear in a dropdown list for that Business
Administrator.

Manage Sites

Providers with multiple site locations can use this feature to manage additional sites. Click the Manage All Sites
link to add new provider sites. Additional sites can only be added if the sites share the same taxpayer identification
number. This function will only be needed if the provider site is not found in the DEL database. Sites that share the
same taxpayer identification number will automatically be assigned to the Business Administrator who registered
the first provider site with the same taxpayer identification number.

ﬁ Home Business - Profile - Contracts - Enroliments - Attendance - Documents +

Profile] 2023 -2024 v GrLogoff {3 @

SroadesEsSaes CosonHEssaos

Manage Sites =
Manage All Sites

Voluntary Customer Satisfaction Survey : Mo notifications or alerts to display.

All providers that become contracted with our office
will be contacted to complete a voluntary survey to
gauge your customer service experience with our
Manage All Users office. All responses are anonymous and
confidential and will not affect your contract.

Manage Users

Manage VPK Applications and Contracts

WPK Provider Application
iManage VPK Instructors. Calendars, and Classes
Statewide VPK Provider Contract

WPK Contract Amendment Provider Site Summary Frequently-Used Links

Manage SR Contracts

X Business name: Sara's Test Daycare Center Bright Beginnings L\)
Statewide SR Provider Contract
SR Contract Amendment Doing business as: Sara Test Daycare West Core Competencies (Coming Scon)
Provider ID: 24788 DCF Provider Training
Provider Cost of Care Estimate License number: Provider Portal User Guide
= 2022 -2023 Provider Cost of Care Estimate SSN / Federal ID number: Quality Performance System (QPS)
Accountability 1D: A1T5447 VPK Provider Readiness Rate Website

Preschool Development

Manage Sites

Use this page to add new provider sites and to edit or inactivate provider sites for which you have the necessary administrative access

If a button is disabled, it means that you don't have sufficient access to use that function [%r that particular provider site. Please see your site adminstrator if you need additional access.

Location name License number Accountability ID Address Actions

Sara Test Daycare West EXEMPT A172447 1313 SAN LUIS RD, TALLAHASSEE, Edit | Manage Users
FL 32304

Add Site

24



After clicking the Add Site button, the following message will display:

Add New Site

To add a new site for your business, first type the license, registration, or exemption
number of the new site, and then click Verify License to verify that the license number is
available for use with the system.

License/Registration/Exemption number, or EXEMPT*

Verify License

Save Cancel

If the new provider site matches, the location information will be pre-populated.

25



If the new provider site does not match, the location information must be entered by the Provider Portal user.

Add New Site

To add a new site for your business, first type the license, registration, or exemption
number of the new site, and then click Verify License to verify that the license number is
available for use with the system.

License/Registration/Exemption number, or EXEMPT*
8 Verify License

Legal status*

w
Doing Business As (DBA) name*
Provider type*®
w
Address line 1*
Address line 2
City*
State
Florida
Zip code *®
County of physical location®
w
Save Cancel
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After clicking the Register button, the following message may display:

© Address Verification

© USPS standardized address is 250 MARRIOTT DR TALLAHASSEE FL 32399-
6573
Would you like to use this address instead of entered address?

MO Yes

Click the Yes button to accept the standardized United States Postal Service address. Click the No button to go
back to the previous screen to re-enter the address information.

Adding a Site for a Physical Location Change
If a new site is needed due to a change in location of an existing site, check the box for This site is being created
due to a change in Physical Address.
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Select the site that had the change in location from the list of Provider sites.

NOTE: Only sites for which the user has Business Admin permissions will be displayed in the list.

After clicking the Register button, the following message may display:

Click the Yes button to accept the standardized United States Postal Service address. Click the No button to go
back to the previous screen to re-enter the address information.
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Manage Users
Click the Manage All Users link to edit, add, and inactivate provider site users.
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To edit the role of a Provider Portal user, click the Edit button.

Provider User Roles:

— Business Administrator — Able to edit the provider profile and principal business information that is
shared among associated provider sites; able to add provider sites and users; submit profiles and
profile updates; and create contracts. This role would typically be assigned to an owner.

— Site Administrator — Able to edit the provider profile associated to their site add provider users for a
site but cannot create a new site. This role would typically be assigned to a principal or director.

— User — Able to perform administrative tasks based on permissions granted by the Business
Administrator or Site Administrator. This role would typically be assigned to teachers and aides.

After changing the role, click the Save button to continue.
Edit User Permissions

Make the desired changes to the user's role and permissions, and then click Save.

Role®

Business Administrator
Site Administrator
User

Save Cancel

30



Adding a User
To add a user, click the Add User button.

Add New User

To add a new user to your site, first type the user name (email address) of the new user,
and then click Check User Name to see if the user is already registered with the system.

User name*

Check User Name

Save Cancel
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In the user name field, the Provider Portal user will enter the email address of the new user. If the user already has
an account in the Provider Portal, the user role must be selected. Click the Save button to continue.

r

Add New User

To add a new user to your site, first type the user name (email address) of the new user,
and then click Check User Name to see if the user is already registered with the system.

User name*
oeldemonstration+5@gmail.com Check User Name

The specified user account already exists in the system, so no further account information
is needed. Select the role and permissions for the new user, and then click Save.

Role*®

Business Administrator
Site Administrator
User

w0
1=
I

Cancel

In the user name field, the Provider Portal user will enter the email address of the new user. If the user does not
exist in the system, the user’s information and role must be entered. Click the Save button to continue.

Add New User

To add a new user to your site, first type the user name (email address) of the new user,
and then click Check User Name to see If the user is already registered with the system

User name™®

oeldemonstration+7@gmail.com Check User Name

The specified user account does not yet exist in the system. Please complete the form
below, and then click Save

Password *

Confirm password*

First name*

Middle name

Last name*

Role*

Business Administrator
Site Administrator
User

. -
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Once the new user has been added, an email will be sent to the new user by DONOTREPLY@oel.myflorida.com.

Hello Jamie Ledbetter,

You are receiving this message because you have been given permission to access Jim's House of Learning 2 with your user account in Florida’s statewide early leaming Provider Portal.
You may now log on to the Provider Portal with your user name and password to get started.

If you do not have your current user name or password, contact Jim Ledbetter at oeldemonstration+3@gmail.com for your log in information.

ELC of the Big Bend Region

(666) 973-9030
http-fwww.elebigbend orgl

Please do not reply to this message. Replies to this message are routed to an unmonitored mailbox. If you have any questions, please contact your Early

Learning Coalition at the number listed above.

The User role has a set of permissions that can be individualized for each User. Each option is unchecked by default
and must be checked to add to the User. Click the Save button to continue.

Edit User Permissions

Make the desired changes to the user's role and permissions, and then click Save.

Role*™
| v |

Permissions

Aftach Profile Documents:

Create Banking Information

Create Calendar

Create Profile

Create SR Contract

Create WVPK Contract

Edit Banking Information

Edit Calendar

Edit Profile

Edit Site

Edit SR Contract

Edit "/PK Contract

Manage ASQ

Manage Document Library

Manage Messages and MNotifications
Manage Cther

Modify and Submit SR Altendance Rosters
Modify and Submit VPK Attendance Rosters

Reports

L S O O Y T N N U L SR VRN SR VI UL SR NN UNEE VR S

Review Afiendance Rosters

Save Cancel
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Adding a Business Administrator to Multiple Sites

To add a Business administrator to multiple provider sites, click the Add User button in the “Manage Multiple
Providers” section.

NOTE: “Manage Multiple Providers” is only available to existing Provider Portal accounts with a Business
Administrator role.

In the user name field, enter an email address for the new Business Administrator account. Click the Check User
Name button.

If the email address does not exist in the system, the Password and Name fields must be filled to create a Provider
Portal Account.
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Click the Select Providers dropdown arrow.

NOTE: The Role dropdown only displays Business Administrator and cannot be changed.

Select the provider sites where the user will have a Business Administrator role, then click the Save button.

The Add User Confirmation message will pop up verifying account access for the provider site.

35



Inactivating a User
To inactive a user, which will remove the user from the site, click the Inactivate button.

If the Provider Portal user discovers that an email address has an error after it has been entered, the user can add
the correct email address by clicking the Add User button, entering the required information, and then click the
Save button. Then, the user will click the Inactive button for the email address which has the incorrect email
address. For example, from the above Manage All Users screen, if the Business Administrator’s email address was
incorrectly entered as oeldemonstation@gamaial.com, the process would be to click the Add User button and
create oeldemonstration+3@gmail.com, click Save, and then click Inactivate for oeldemonstation@gamaial.com. It
is important to create the correct email address first before inactivating the incorrect email address.
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Provider Cost of Care Estimate

The Provider Cost of Care Estimate pop-up message will appear for all providers that have an incomplete or Active
2022-2023 provider profile in EFSM. The providers do not have to have School Readiness or VPK contracts to
complete the cost of care estimate.

The pop-up message will appear on the provider dashboard after logging in and will continue to pop up until the
provider completes and submits the estimate.

May 31, 2023 is the last day the provider will be able to submit the estimate. The pop-up message will not appear
after the deadline.

Click the Proceed to Provider Cost of Estimate button in the pop-up message OR click the link in the Common
Tasks list.

vianage A Es&rs

Manage VPK Applications and Contracts

WPK Pravider Application

Manage VPK Instructors, Calendars, and Classes
Statewide VPK Provider Contract

WPK Contract Amendment

Manage SR Contracts

Statewide SR Provider Contract
2R Contract Amendment

Surveys/Grant Applications

= ARPA
e ARPA Round 1 Application
« ARPARound 1 Installment 2

« ARPA Round 2 Application

Provider Cost of Care Estimate
« 2022 - 2023 Provider Cost of Care Estimate
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The link will remain in the Common Tasks list after the May 31, 2023 deadline to allow the provider to view the
data that was submitted, but the form will not be editable. The link will not display after May 31 if the estimate is
not submitted.

NOTE:

e The provider cost of care estimate may be saved at any time by pressing the Save for Later button at the
bottom of the application.

e  The Save for Later button will return you to the provider dashboard where they can access the cost
estimate at a future time by clicking the Provider Cost of Care Estimate link located under Provider Cost of
Care Estimate on the left of the provider dashboard.

o Allfields are required to be completed for the Submit button to appear.

e All applications must be submitted no later than May 31, 2023.

The Child Care Provider Cost of Care Estimate will appear in a New status. The status will remain New until the
provider saves at least one answer.
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Provider Name Provider ID Licensing Capacity

Along The Way Learning 24585 24

Estimate

1 How much has your program(s) spent on materials and curriculum frem July 1, 2022, threugh June 30, 20237 These costs could include but are not limited to the following items:
= Educational materials - includes books, toys, puppets, wall posters. manipulatives, consumable items like paint, paper, crayons
= Curriculum - all print and electronic textbooks, instructional materials, lesson plans, teacher guides. workbooks, tests, and other curriculum-related materials, annual subscriptions, and all supplemental
instructional materials

I

2 How much has your program(s) spent on food/food preparation from July 1, 2022, through June 30, 20237 These costs include the total amount spent, including those expenses that may have been
reimbursed by the Florida Department of Health's Child Care Food Program or any other reimbursements received. These costs could include but are not limited to the following items:

«+ Meals and snacks, including drinks. formuia

+ Kitchen supplies

+ Consumables such as dish soap. containers. foil, cling wrap, etc.

$

I

3 How much has your program(s) spent on maintenance costs from July 1, 2022, through June 30, 20237 These costs include all expenses associated with keeping all buildings and equipment
necessary for the safe delivery of early care and education services. Examples include, but are not limited to, the cost of the following:

- Maintenance staff or services

= Yard/playground maintenance

= Replacing or repairing furnishings, equipment, and buildings systems such as HVAC, electrical, and plumbing

$

|

4 How much has your program(s) spent on regulatory fees from July 1, 2022, through June 30, 20237 These costs could include but are not limited to the following items:

= Licensing
« Accreditation (for example, Gold Seal, national associations, and memberships)

$

l

5 What is your average enroliment from July 1, 2022, through June 30, 2023? To calculate average enroliment, sum the total of each month's enroliment and divide by the total number of months used
in the calculation.
« Forexample, if you were open the entire time frame and enroliments were 12 monthly (July - December 2022) and 15 monthly (Jan - June 2023), the total enroliments would equal 72 (12x6) + 90 (15 x 6) =
162. Take the total enroliments and divide by total months (12) or 162/12 = 13.5 rounded up to 14.

Average Enrollment

l

& How much has your program(s) spent on operational costs from July 1, 2022 through June 30, 20237 Operational costs refer to the costs incurred to maintain the day-to-day operations of your
business. Examples of operational costs include but are not limited to:

Payroll

Benefits

Rent or mortgage

Facility expenses (utilities, insurance, maintenance)
Training expenses

Equipment and supplies

Other goods and services

l

Note: The total operational cost reported in item #5 will be divided by average enroliment reported in item #5 to calculate a per-child operational cost from July 1, 2022, through June 30, 2023
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After clicking the Save For Later button, a confirmation pop-up message will appear. Click Yes and the page will
refresh displaying the Incomplete status as well as the datetime stamp and user that saved the answer(s).

@ Confirm

You have opted to save your progress in the estimate and exit. When
you are ready to continue, click the Provider Cost of Care Estimate
link located under Provider Cost of Care Estimate on the left of the
Provider Dashboard.

Yes Cancel

Once an answer is saved, the status changes to Incomplete.

Provider Cost Of Care Eslimale

Provider Name Provider ID Licensing Capacity
Alang The Way Leaming 24585 2
Estimats

1 How much has your program(s) spent on materials and curriculum from July 1. 2022, through June 30, 20232 These costs could include but are not limited to the following items:

« Educationsl materisls - includss books, toys. puppats, wall posters, manipulatives, consumatie ftems ke paint paper, crapens
= Curriculum - all print and electronic textbooks, instructional matarials, lesson plans, teacher guides, wiorkhooks, tests, and other curriculum-relsted materials, annual subscriptions, and all supplemental instructional materials

5| 10,00

2 How much has your program(s) spent on foodifood preparation from July 1. 2022, through June 30, 20232 These costs include the total amount spent, including those expenses that may have been reimbursed by the Florida Department of Health's Child Care Food Program or any other reimbursements
received. These costs could include but zre not limited to the following itsms:

= Msals and snacks, including drinks, formula

- Kitzhen supplies

= Consumables such as dish soap, containers, fod cling wrap, ete

5| 10,00

3 How much has your program(s) spent on maintenance costs from July 1, 2022, through June 30, 20237 These costs include all expenses associated with keeping all buildings and equipment necessary for the safe delivery of early care and education services. Examples include, but are not limited to, the cost
of the following:

enance staff or senvices

yground mainiznance

« Replacing or repairing furnishings, equipment, 2nd buidings systems such 2z VAT, glecrical, and plumbing

s| 10,00

4 How much has your program(s) spent on regulatory fees from July 1. 2022, through June 20, 20237 These costs could include but are not limited to the following items:
- Licznsing
 Aceraditation (for example, Gold Seal, national associations, and memberships)

5| 10,00

5 What is your average enrollment from July 1, 2022, through June 20, 20237 To calculate average enrcliment, sum the total of each month's enroliment and divide by the total number of months used in the ealculation.
~ For example. if you were open the entir fime frame and enraliments were 12 montnly (July - December 2022) and 15 monthly {Jan - June 2023), the total enrolments would egual 72 (12x6) + 80 (15 x 6} = 182. Take the total enreimants and divide by totsl months (12} or 162112 = 13.5 roundad up to 14

Average Enrollment

5
& How much has your program(s) spent on operational costs from July 1, 2022 through June 30, 20237 Operational costs refer to the costs incurred to maintain the day-to-day operations of your business. Examples of operational costs include but are not limited to:
Payrol
Bengiis
Rent or mortgage
Faciity ses | insurance, maintenance]

Training expenzes
Equizment and suppies
Other goods and seruicss

5| 10,00

NOTE: Negative numbers (-1.00) and letters will not save.
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When all the questions are answered, the Submit Estimate button will appear at the bottom of the page.

Note: The total operational cost reported in item #6 will be divided by average enrollment reported in item #5 to calculate a per-child operational cost from July 1, 2022, through June 30, 2023.

Save For Later ‘Submit Estimate Cancel

After clicking the Submit Estimate button, a confirmation pop-up message appears. Click Yes.

When the submission is complete, a Success pop-up message. Click OK.

The page reloads and the status is Complete.

If the provider has submitted the estimate and changes need to be made after the submission, the questions and
button on the page will remain active until June 1, 2023 of this year. The previous answers are stored in the
database.
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Broadcast Messages (not yet available)
The Broadcast Messages section of the Provider Dashboard will display all messages sent by the local early learning
coalition to all providers in the coalition service area. Click the message title to see the full text of the message.

a4 )

Coalition Messages
The Coalition Messages section of the Provider Dashboard displays messages sent by the local early learning
coalition to a specific provider. This is a one-way communication; the provider cannot email the coalition directly

from the portal. Click the message title to see the full text of the message.

-
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Frequently Used Links
The Frequently Used Links section of the Provider Dashboard has links to web pages with information about
statewide provider requirements, training and services.

Completing the Provider Profile

After registering as a provider, the next step is to complete the Provider Profile.

Request Assistance
If a Provider Portal user needs assistance filling out any information in the Provider Profile, click the Request

Assistance button.

]

Then, complete the field, briefly describing the need for assistance. Click the Submit button to send the request.
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© Regquest Profile Assistance

‘You are requesting assistance from the early learning coalition with your Provider
Profile. You will not be able to make changes to your profile while the coalition is
reviewing your request

W Briefly describe the issue that you need assistance with.

After clicking Submit, the following message will display:
©  Message From Office of Early Learning

The early leaming coalition has received your request for assistance. Someone will
review your request and contact you by telephone, email, fax, or mail when your

request is ready to be processed. Contact your local Early Learning Coalition if you
need immediate assistance

Ok

The Provider Portal user will not be able to edit the profile once the request for assistance is submitted; however,
coalition staff will be able to edit information in a profile while providing assistance to a Provider Portal user.

The request for assistance can be cancelled by the Provider Portal user by clicking the Cancel Assistance Request
button.

If a Provider Portal user cancels the assistance request, the following message will display and the user will
complete the field, briefly describing the reason for cancelling the request. Click the Submit button to continue.

€ cancel Assistance Request

You have selected to cancel your request for assistance prior to the early leaming
coalition reviewing it.

W8 Please provide the reason for your cancellation
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After cancelling the request, the following message will display:

@  Message From Office of Early Learning

The profile assistance request to your early learing coalition has been canceled
You are now able to edit your profile.

Ok

Business Information

The Business Information page collects business information about the provider, including business name and
address information, and it is shared among additional sites (if any). Only a Business Administrator may edit the
information on this page.

NOTE: This information was previously captured in the Business tab of the provider profile. Although the Business
Information page is now separated from the provider profile, it must be completed before the profile may be
submitted.

Tool tips, indicated by the i symbol, are available to provide useful information to Provider Portal users about
specific terms in the Provider Profile. Click the @ to see the message.

To complete the Business Info page, click the Business dropdown menu from the Provider Dashboard.

Then, click Business Info.
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Business Information

1. Business Name Associated with Your Taxpayer Identification Number* €

Jim's House of Leaming 3

2. Taxpayer Identification Number® €)
885868888

3. Owner Information €)

Owner Name * Owner Telephone Number®
Jim Ledbetter (555) 555-5555
Owner Email Address * Owner Phone Type*
fake@foo.com Mobile Phone v

4. Owner's Designee or Contact Person Information €)

Designee/Gontact Name * Designee/Contact Telephone Number®
Jim Ledbetter (555) 555-5555
Designee/Contact Email Address*® Designee/Contact Phone Type *
fake@foo.com Unknown ~

5. Business Ownership Type® €

Corporation v

6. Physical Address Information €}
Address Line 1*

250 MARRIOTT DR
Address Line 2

city* State ® Zip Code ™

TALLAHASSEE FL v 32301

7. Mailing Address Information §)
™ Mailing address is the same as the principal address.
Address Line 1*

250 MARRIOTT DR

* Altering this address may trigger USPS verification
Address Line 2

city* State ® Zip Code *

TALLAHASSEE FL v 32301

8. Payment Mailing Address Information §)
¥ Payment address is the same as the mailing address.
Address Line 1*

250 MARRIOTT DR

= Altering this address may trigger USPS verfication
Address Line 2

city* State® Zip Code®

TALLAHASSEE FL v 32301

Cancel
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Manage External Service Users - Renaissance VPK FAST Star Early Literacy

The Manage External Service Users page in the Provider Portal is a way to assign unique Service User IDs to
authorized provider and coalition users of the Renaissance VPK Florida Assessment of Student Thinking (FAST) Star
Early Literacy system. This will allow Renaissance to easily create accounts and login credentials for users of their
system.

Provider authorized users are VPK Program owners, directors, or VPK directors that are responsible for the
administrative tasks for FAST Star Early Literacy implementation.

Coalition authorized users are ELC FAST contacts that are responsible for the administrative tasks for FAST Star
Early Literacy implementation and compliance.

To access the Manage External Service Users page in the Provider Portal, a Business Administrator navigates to the
Business menu > External Service Users > Renaissance.

Users who are authorized to have access to the Renaissance VPK FAST system are listed.
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Adding An Authorized User

To add a user, Click the Add User button. For multi-site providers, this will add a user to the selected site only.

In the pop-up window, enter the user’s first name, last name, and email address. The provider ID, accountability
ID, and vendor’s service name are pre-populated. Then, click Continue. Or click Cancel to close the window
without adding the user.

NOTE: If an email address is attempted to be used for a new account but it belongs to an already created account,
a message will display that “This email address is already in use.” The user will need to:

e  Enter a different email address, or

e Assign the existing user account to their center, or

e Cancel to quit
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When Continue is selected, the Confirm Add User pop-up displays. Click OK to add the user or Cancel to quit.

The added user displays on the external service users list for the selected provider and can be edited or deleted.
The user now has a unique “Service User ID.”

Associating A User to Multiple Providers

The same name and email combination can be used to authorize that user to access multiple providers on
Renaissance. For example, if “John Doe johndoe@provider.com” is an existing Renaissance user for Site A, and
that same user should also have access to Site B, Site B must be selected from the Sites dropdown to add the user.
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Then, click the Add User button and repeat the steps to add “John Doe johndoe@provider.com” to Site B.

NOTE: This user will have the same Service User ID across all providers for which they are an authorized user.

Editing A User
To edit an existing user’s name, address, or email, click the Edit button under the Actions column.

In the pop-up window, modify the user information, then click Continue to save the changes or Cancel to quit.

NOTE: If the edited user is a service user on multiple sites, the changes will be applied for that user on all sites.
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Deleting A User
To remove a user’s Renaissance access for a provider, click the Delete button under the Actions column.

The Confirm User Removal pop-up displays. Click OK to remove the user or Cancel to quit.

NOTE: If the deleted user is associated with multiple providers, their Renaissance access will only be removed for
the specific provider selected in the Sites dropdown. To remove the user’s access for additional providers, select
another site in the Sites dropdown and repeat the steps to delete the user.
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Profile
A Provider Portal user must fill out all information in each tab, and click the Next button to continue filling out the

provider profile information. Click the Back button to return to the previous tab.

Tool tips, indicated by the i symbol, are available to provide useful information to Provider Portal users about
specific terms in the Provider Profile. Click the ® to see the message.

To complete the Provider Profile, click the Profile dropdown menu from the Provider Dashboard.

Then, click Provider Profile.
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Yellow Warning Symbols

Yellow warning symbols will appear on certain fields on the following tabs: General, Facility, Services, Curriculum,
Staffing & Capacity, and Documents.

If the Provider Portal user hovers over the yellow warning symbol, the following message will display.

If a change is made, the coalition will review the change and change the profile status to Incomplete to allow the
Provider Portal user to re-submit the VPK-APP. The user will receive the following email from
DONOTREPLY@OEL.myflorida.com.

53



Step 1 — General

The General tab collects basic information about the provider, including provider types and whether or not there is
interest in contracting with the early learning coalition to provide School Readiness or Voluntary Prekindergarten
(VPK) Education services.

General
1. Do you want to have your program referred to families seeking child care listings? €

8 Yes No

2. Do you want to complete a contract to participate in the School Readiness Program?
8 Yes No

2.1 Have you completed the Health & Safety Inspection by Department of Children and Families?
® Yes () No

3. Do you want to complete a contract to participate in the Voluntary Prekindergarten (VPK) Education Program?
® Yes No

4. Do you want to complete a contract to receive local funding? €}
® Yes No

5. Are you a Gold Seal provider? §)
® Yes No

5.1 Gold Seal Accreditation (select one)

Gold Seal for Birth to 5

6. Are you an accredited provider?
® Yes No

6.1 Accreditation (select all that apply)

OTHER x
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Step 2 — Facility

The Facility tab collects contact information for the provider. The Provider Portal user is required to enter contact
information for staff responsible for different aspects of the business. If the staff person is an Authorized Contract
Representative or VPK Authorized Contract Representative, click the checkbox below each section (Director, VPK
Director, etc.).

All VPK Providers: Each child enrolled in VPK must be assessed under the Coordinated Screening and
Progress Monitoring Program (CSPM), known as the Florida Assessment of Student Thinking (FAST) using
Star Early Literacy. Each provider must designate a primary contact to receive information regarding
participation. A CSPM secondary contact is optional.
e CSPM primary and secondary contacts should not be the same.
o If both CSPM primary and secondary contacts are populated, the system compares the email
addresses and will display an error if the primary and secondary contact emails are the same.

1. Doing Business as Name (DBA)

Ventura Day School

2. Contact
Telephone Number* Phone Type*®
(850) 555-5555 Land Line v
Fax Number Email Address*

jennifer.ventura prod+testprovidergensralcontact@gmail.com

3. Physical Address of Facility

Address Line 1* Address Line 2

City* State® Zip Code *®

Tallahassee Florida - 3231

County*®
KREPS ISLAND -

4. Director
Director Name * Director Email *

jennifer.ventura.prod+testprovider. director@gmail.com

Director Telephone Number* Director Phone Type®

(850) 555-5555 Land Line v

Is Authorized Contract Rep
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5. VPK Director

[ VPK Director information is the same as the Director information.

VPK Director Name *

VPK Director Telephone Number*®

(850) 555-5556

Is VPK Authorized Contract Rep

VPK Director Email *

jennifer.ventura prod+testprovider.vpkdirector@gmail.com

VPK Director Phone Type *

Land Line

5.1. VPK Coordinated Screening and Progress Monitoring (CSPM) Contact
CSPM Primary Contact information is the same as (select one):
[ Owner
[ Owner Designee

[ VPK Director
CSPM Primary Contact Name *

CSPM Primary Contact Telephone Number®

CSPM Secondary Contact information is the same as (select one):
[ Owner

[ Owner Designee

[ VPK Director

CSPM Secondary Contact Name

CSPM Secondary Contact Telephone Number

CSPM Primary Contact Email *

CSPM Primary Contact Phone Type *

Select Type

CSPM Secondary Contact Email

CSPM Secondary Contact Phone Type

Select Type

Public Records Exemption Indicator

Individual provider contacts may be marked as exempt from public records disclosure.
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NOTE: If the childcare program is certified by the U.S. Department of Defense and is operating on a military
installation, an additional question will display after question 8, but only if the provider meets one of the following
conditions:

6. Legal Status 7. Exemption Reason 8. Provider Type

Licensed N/A Center

Licensed MN/A Family Child Care Home
Licensed N/A Large Family Child Care Home
Registered N/A Family Child Care Home
Exempt Military Center

Exempt Military Family Child Care Home
Exempt Military Large Family Child Care Home

The additional question asks, “Are you an accredited childcare program certified by the United States Department
of Defense AND operating on a military installation?”. The Provider Portal User can select Yes or No. If the user
selects Yes, a pop-up message will appear asking the user to verify their selection. After submitting the profile, this
selection cannot be changed.

6. Legal Status

Exempt -

7. Exemption Details
Exempt Number *§) Expiration Date

EXEMPT 1213172022 i

Exemption Reason*

Military -

8. Provider Type *©

Center -

Are you an accredited child care program certified by the United States Department of Defense AND operating on a military installation? *€)
@ Yes O No
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Additional Facility Contacts

Add Mew Confact

When the Add New Contact button is clicked, the Provider Portal user can create additional provider contacts for
the profile. Individual contacts may be marked as exempt from public records disclosure.

Contact Type*®

Name* Email*

Primary Telephone Number* Primary Telephone Extension

Primary Phone Type*®

Select Type v

Secondary Telephone Number Secondary Telephone Extension

Secondary Phone Type

Select Type v

Fax

Authorized Contract Rep

() Exemption from Public Records Disclosure under s. 119.071 (4) (), F.S. €@

Save Cancel

Contact Type
" . | Contact Type
| .
| General Contact Information | A
SR Contact Before School Contact ~
CCRR Contact After School Contact
Assistant Director Finance
Facility Director Food & Nutrition
Operations Manager Attendance
Principal Camp Contact
Assistant Principal B Admissions
Extended Day Contact Enroliment e
Administrator
Associate Director v

Other Contact
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Step 3 — Services
The Services tab collects information on the ages of the children in provider care, as well as different provider
services.

Sernices

. Age of Children for which Care is Provided *

-

MinimnmApe' Maximum Aue'

1 Months A4 2 Months -

M

Programs Offered (select all that apply)

Before School=  Migrant Head Startx  Playgroup = -

3. About My Program [select all that apply)™

Music lessons=  Dancex  Swim lessons = -

4. Languages Spoken by Staff (select all that appiy) ™

English>=  Spanishx  Haitian/Creole > -

5. Other Spoken Languages§)

6. Meals {select all that apply) ™
Moming Snackx  Afternoon Snack x -
7. Do you provide transportation services?™
@ Yes O No
8. Transportation (select all that appiy)

Transporiation teffrom local school = -

8.1 Trangportation to/from Local School

School Transportation To Transportation From
Add school

Mickey Mouse LR | KR -

9. Do you
@ Yes O Mo

9.1 Description of Cl D Program (250 max)

blah

10. Is your program equipped to care for children with special needs?*
) Yes @ Mo

11. Is your facility wheelchair-accessible? ™
@ Yes O No

12. Does your pr ility offer ic services to children?*
@ Yes O Mo

13. Do you participate in a quality rating system? *§}
@ Yes O Mo

14, Affiliation - Not for Profit™®
O Yes @ Mo

15. Military Child Care™€)
® Yes O Mo
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Step 4 — Curriculum

The Curriculum tab collects information about the provider’s curriculum. A provider may choose multiple curricula
from the list. If the provider is a school readiness provider, an approved curriculum must be chosen. If no approved
curricula are being used by the provider, the Provider Portal user should select “Other.” If a provider does not see
their curricula listed, choose “Other” as the curriculum.

Step 5 — Fees & Discounts

The Fees & Discounts tab collects information about fees the provider assesses the parent. The Provider Portal
user should enter all applicable fees. All amount fields must have either a dollar amount or zero entered. If a fee is
not applicable, the amount entered must be “0.” If there are no family discounts offered, the selection must be
“None.”

Fees and Discounts

1. Fees in Addition to Weekly Rates

Description € Amount Frequency Per Child | Per Family

Annual® s 7s Monthly = || Perchid -
Application/Registration * s s Annual « | Perchi -
Diapers® s |0 - -
Early Drop Off*® N - -
Extended Stay® s | 0 - -
Insurance® s | 0 - -
Late Payment™ s 5 Daily - | | Perchild -
Late Pick-Up* 5 15 Hourly - Per Child -
Meals/Snacks® N - -
Returned Check® s | 25 As nesded < | | PerFamiy -
School Age® s | 475 Monthly - || PerChid -
SuppliesiMaterials® N . -
Waiting List Registration* s 0 - -

2. Family Discounts Offered (select all that apply)

None = -

3. Other Family Discounts €}
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Step 6 — Hours of Operation

The Hours of Operation tab collects information on the type of schedules offered for care. The Provider Portal user
must click the checkbox next to the desired day of the week before inputting hours of operation for that day. The
default hours of operation for each day are 6:00 a.m.— 6:00 p.m. An Enhanced Schedule is available.

Facility Hours of Operation

1. Enhanced Schedule (select all that apply)

M ‘

24-hour Care |A
Drop in Care
Early/Extended Care
Emergency/Temporary
Evening
Full Year
Full-time
Overnight v
Part time
e O [ —
™ Tuesday ¥ 24 hours 12:00 AM o] 11:59 PM (o] 2398
Open Close Total Hours
i Wednesday W1 24 hours 12:00 AM o] 11:45 PM (o] 2375
Open Close Total Hours
[ Thursday 24 hours 12:00 AM (o] 12:00 AM (o] 0
Open Close Total Hours
[ Friday 24 hours 12:00 AM (o] 12:00 AM [o] 0
Cpen Close Total Hours
[ Saturday 24 hours 12:00 AM o] 12:00 AM (o] 0
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Step 7 — Staffing & Capacity

The Staffing & Capacity tab collects information on how many children the facility will or can care for. These
questions are asked by age group. For each care level, the Provider Portal user should enter the highest number of
teachers and children for all classrooms for each care level. This tab does not calculate staff-to-child ratios, but
stores staffing and capacity numbers for local early learning coalition review.

Staff-to-child Ratio is the number of children that an individual teacher is responsible for. To reflect the actual
ratio, the “Teachers in Classroom” column should always be 1. For example, if you have 2 teachers with one class
of 20, you should list 1 “Teacher in Classroom” with 10 “Children in Classroom” and a “Group Size” of 20. If you
follow the state mandated ratios for a center or facility, please see the example below. You can omit the age
groups you do not serve.

Group Size is the maximum number of children, by age, that can be in a single classroom at any given time. If you
follow the state mandated group sizes for a center or facility, please see the example below. You can omit the age
groups you do not serve.

1. Staff-to-Child Ratio in Your Program )

Care Level Teachers in Classroom Children in Classroom Group Size €)
<12 Months 1 : 1 1
12 < 24 Months 0 : 0 0
24 < 36 Months 0 2 0 0
36 < 48 Months 0 : 0 0
48 < 60 Months 0 E 0 0
60 <72 Months 0 : 0 0
In School 0 g 0 0
Special Needs 0 : 0 0
VPK Class 0 E 0 0
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2. Training/Educational Credentials in Your Program

Training/Education Type Number of Staff €
FCCH 30 HOUR TRAINING 1
40/45 HR INTRO CHILD CARE 0
AA/AS NONCHILD RELATED 0
AAAS EARLY CHILDHOOD OR RELATED FIELD 0
DIRECTOR CREDENTIAL ADV/ 0
DIRECTOR CREDENTIAL LEVEL 1 0
DIRECTOR CREDENTIAL LEVEL 2 0
BA/BS NONCHILD RELATED 0
BA EARLY CHILDHOOD OR RELATED FIELD 0
BEHAVIOR OBSERVATION 0
DIRECTOR (NON VPK) 0
GED/HIGH SCHOOL 0
EARLY (EMERGENT) LITERACY 0
FCCPC/ECPC/ICCACICDAE 0
MA DEGREE EARLY CHILDHOOD 0
MA NONCHILD RELATED 0
NATL EARLY CHILDHOOD CERT 0
SCHOOL-AGE CREDENTIAL 0
VPK DIRECTOR CREDENTIAL 0
OTHER- LIST 0
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Example: Child Care Center 1
This example uses the state mandated minimum staff-to-child ratios and maximum group sizes permitted for
centers.

General Facility Services Curriculum Fees & Discounts Hours of Operation Staffing & Capacity Private Pay Rates Closures Calendar

Staffing and Capacity

1. Staff-to-Child Ratio in Your Program €

Care Level Teachers in Classroom Children in Classroom Group Size €
< 12 Months 1 E 4 12
12 < 24 Months 1 . 6 12
24 < 36 Months 1 E 1" 22
36 < 48 Months 1 B 15 30
48 < 60 Months 1 . 20 40
60 < 72 Months 1 B 25 40
In School 1 . 50
Special Needs o] : 1] 0
VPK Class 1 E 1 0

Example: Child Care Center 2

This example uses more stringent staff-to-child ratios and group sizes that are smaller than the state mandate for
centers.

Staffing and Capacity

1. Staff-to-Child Ratio in Your Program €)
Care Level Teachers in Classroom Children in Classroom Group Size €
< 12 Months 1 . 3 6
12 < 24 Months 1 : 5 10
24 < 36 Months 1 : 10 10
36 < 48 Months 1 : 12 12
48 < 60 Months 1 g 20 | 20| B
60 < 72 Months 1
In School 1
Special Needs 1
VPK Class 1

For more information on staff-to-child ratios and group sizes for facilities, please visit the School Readiness Health
and Safety Standards Handbook.
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Example: Family Child Care Homes 1

A family day care home is allowed to provide care for one of the following groups of children, which includes
household children under 13 years of age. Below are examples of how to fill out this table using the state

mandated minimum ratios.
**The group size column should never exceed 10 for a family child care home.

This example uses the maximum of four children from birth to 12 months of age.

Staffing and Capacity

1, Staff-to-Child Ratio in Your Program €)

Care Level Teachers in Classroom Children in Classroom Group Size €
< 12 Months 1 : 4 | 4 E ‘
12 < 24 Months 1

24 < 36 Months 1

36 < 48 Months 1

48 < 60 Months 1

60 < 72 Months 1

In School 1

Special Needs i}

VPK Class 1

Example: Family Child Care Homes 2

This example uses the maximum of three children from birth to 12 months of age, and other children, for a

maximum total of six children.

Staffing and Capacity

1. Staff-to-Child Ratio in Your Program €}

Care Level Teachers in Classroom Children in Classroom Group Size @

< 12 Months 1 : 3 3

12 < 24 Months 1 : 3 ‘ 9 : |
24 < 36 Months 0 : 4] 0

36 < 48 Months 0 : o o]

48 < 60 Months 1] : 1] 0

60 < 72 Months 1] : o 0

In School 1] : 1] 0

Special Needs 0 : 0 0

VPK Class 4] : (1] 0
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Example: Family Child Care Homes 3
This example uses the maximum of six preschool children if all are older than 12 months of age.

Staffing and Capacity

1. Staff-to-Child Ratio in Your Program €}

Care Level Teachers in Classroom Children in Classroom Group Size €
<12 Months 0 : 0 0
12 < 24 Months 1 . 2 2
24 < 36 Months 1 . 2 2
36 < 48 Months 1 : 2 2
48 < 60 Months 0 . 0 0
60 < 72 Months 1] . 0 Q
In School 0 g 0 0
Special Needs 0 : 0 0
VPK Class 0 E 0 0

Example: Family Child Care Homes 4
This example uses the maximum of 10 children if no more than 5 are preschool age and, of those 5, no more than
2 are under 12 months of age.

Staffing and Capacity

1. Staff-to-Child Ratio in Your Program €)

Care Level Teachers in Classroom Children in Classroom Group Size €

<12 Months 1 . 2 2

12 < 24 Months 1 . 2 2

24 < 36 Months 1 . 1 1

36 < 48 Months 0 . 0 Q

48 < 60 Months 0 . 0 0

60 < 72 Months 0 . 0 Q

In School 1 : 5 | 5 B
Special Needs 0 : 0 0

VPK Class 0 . 0 0
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Example: Large Family Child Care Homes 1
A large family child care home is allowed to provide care for one of the following groups of children, which
includes household children under 13 years of age.

**The group size column should never exceed 12 for a large family child care home.

This example uses the maximum of 8 children from birth to 24 months of age.

Staffing and Capacity

1. Staff-to-Child Ratio in Your Program €9

Care Level Teachers in Classroom Children in Classroom Group Size €
<12 Months 1 . 3 3
12 < 24 Months 1 : 5 5
24 < 36 Months 1] . Q 0
36 < 48 Months 1] : Q 0
48 < 60 Months 1] . Q 0
60 < 72 Months 1] : Q 0
In School 0 E i} 0
Special Needs 0 : 0 0
VPK Class 1] : Q 0

Example: Large Family Child Care Homes 2
This example uses the maximum of 12 children, with no more than 4 children under 24 months of age.

Staffing and Capacity

1. Staff-to-Child Ratio in Your Program €)

Care Level Teachers in Classroom Children in Classroom Group Size €

< 12 Months 1 : 1 1

12 < 24 Months 1 : 1 1

24 < 36 Months 1 : 2 2

36 < 48 Months 1 H 4 4

48 < 60 Months 1 : 4 | 4 :
60 < 72 Months a : 0 0

In School a : 0 o]

Special Needs 4] H 0 0

VPK Class a : 0 0

For more information on staff-to-child ratios and group sizes for family child care homes please visit the School
Readiness Health and Safety Standards
Handbook.http://www.floridaearlylearning.com/sites/www/Uploads/files/Statewide Initiatives/Health and
Safety/HS Handbook Facilities OEL-SR-6202 ADA.pdf
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Step 8 — Private Pay Rates

The Private Pay Rates tab collects information on the provider’s private pay rate based on unit of care and care
level. The Provider Portal user must enter in the private pay rates for each “Unit of Care” and “Care Level” offered
by the provider. Shaded cells do not permit entry. If care is not provided for that Unit of Care and Care Level, no
entry is needed.

Providers that indicate they want to complete a contract to participate in the school readiness program on the
General tab will also have a section on the Private Pay Rates tab to enter the Daily Rates for the School Readiness
Program. The Provider Portal user may edit the $0.00 amount for each “Unit of Care” and “Care Level” offered by
the provider or click on the SR Daily Rate Helper button. The Helper button will automatically calculate the rates
based on the Full Time Monthly Rates or Full Time Weekly Rates, and the Part Time Weekly Rates entered in the
Private Pay Rates section. The rates are also editable after calculation. These rates will be utilized in the
contracting process if the provider enters into a School Readiness contract with an early learning coalition.

NOTE: With Release 3.5, School Readiness providers must now answer a question regarding the family’s
responsibility to pay the differential between the Approved Reimbursement Rate and the Private Pay Rate.
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Step 9 — Closures Calendar

The Closures Calendar tab collects information on any days the provider will be closed. The Provider Portal user
will select all closure days for the provider. Once selected, the date will change from white to blue. The local early
learning coalition may define reimbursable holidays for the School Readiness program, which will be shaded gray.
When a provider closure date and a coalition-defined reimbursable holiday are the same, the date will be shaded
dark blue. A Provider Portal user does not need to include Saturdays and Sundays on the Closures Calendar if
services are not provided on those days.

NOTE: Actual reimbursable holidays will be selected during the contracting process if the provider enters into a
School Readiness contract with an early learning coalition.
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Step 10 — Documents

The Documents tab allows the Provider Portal user to upload documents for the local early learning coalition to
review. Based on provider answers in the provider profile, the Documents tab will display types of documents that
may be uploaded to support a contract to provide School Readiness or VPK services. Users may enter up to five
documents for each document type. Documents uploaded in this tab will also populate in the Document Library
and will be utilized during the contracting process.

Supporting Documents

Certificate of Accreditation

Upload Document...

Certificate of Licensure

Upload Document...

Private Child Care Pay Rates

Upload Document...

IRS Form W-9

Upload Document...
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Step 11 — Review
After reviewing the information for each section, the Provider Portal user must click the Next button to continue.

Click the 4+ to expand and the = to collapse each section below.  Click the to navigate back to that section.
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Step 12 — Sign and Certify

To submit the Provider Profile, the Full Name must exactly match (and is case-sensitive) the name entered on the
Manage Users page. The Provider Portal user must then check the “Check box to certify by electronic signature”
check box and click the Submit button.

¥ Profile Certification And Submittal

By signing this form | certify that:

* | have examined this application and, to the best of my knowledge and belief, the information provided is true and correct.

- If any of the information listed changes, | understand that | must log into my provider portal account and update my information within 14 days of the change.

* lunderstand that my provider profile information will be shared with the Department of Children and Families, Office of Child Care Regulation, for inclusion in the CARES system.
- lalso understand that if | make changes prior to the coalition approving them, | may be out of i with the i of the VPK and or SR programs.

' Authorized Electronic Signature

Full Name

@led( box to certify by electronic signature

Submission date: 6/26/2017

Once the Provider Portal user submits the Provider Profile, the following page will display:

1> You Have Successfully Completed and Submitted your Provider Profilel

Your early learning coalition will process your profile.

Please check your email for important information about your profile.

You can click on the button below to return to the home page.

4 Retum to home page

The Provider Portal user should then find the email sent by DONOTREPLY@oel.myflorida.com.

Hello Jim Ledbetter,

The provider profile you completed for Jim's House of Learning 2 was submitted successfully. You will receive an email that will notify you how to proceed after your provider profile is reviewed and processed by your local early learning
coalition

ELC of the Big Bend Region
{666) 973-9030
hitp:ifwww.elcbigbend.org/

Please do not reply to this message. Replies to this message are routed to an unmonitored mailbox. If you have any questions, please contact your Early
Learning Coalition at the number listed above.
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Managing a Profile as a Provider Portal User

Provider Dashboard

On January 1 of each program year, a button will appear next to the current program year that will allow the
Provider Portal user to migrate all profile information from the current program year to the next program year
(except Closures Calendar dates). To migrate profile information to the next program year, the Provider Portal user

will click the button. In this example, the provider is migrating profile information from the 2018 —
2019 program year to the 2019 — 2020 program year. All information from the 2018-2019 profile will migrate to
the 2019-2020 profile, with the exception of the Closures Calendar. The provider can also skip a profile year and
still be able to create a profile for the current year. For example, the provider had a 2017-2018 profile, but skipped
the 2018-2019 profile. In order to create a 2019-2020 profile, the provider will go to the 2017-2018 profile, click
the Create 2018 button, then go to the 2018-2019 profile, and click the Create 2019 button. The skipped profile
2018-2019 can remain Incomplete.

After a provider is active, a Provider Portal User can edit the Provider Profile, by clicking the Profile dropdown
menu and then clicking the Provider Profile button.

Provider Portal users can manage School Readiness and VPK contracts from the Provider Dashboard.

73



Provider Portal users can manage School Readiness and VPK enrollments from the Provider Dashboard.

Provider Portal users can manage School Readiness and VPK attendance, as well as view reimbursement details for
paid attendance rosters, SR Reimbursement Rates, and Temporary Closures, from the Provider Dashboard.

Provider Portal users can click the Documents dropdown menu to access the Document Library Management
function and view and upload additional documents for coalition review.
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Managing Contracts

Provider Portal users can view contract statuses and edit/download contracts through the Manage Contracts
function.

Manage contracts for Jim's House of Canes & Gators

Show 10 entries «

Type of Coniract niract Name Last Updated View Contract Start Date End Date
45 VPK-APP VPK 10,11A,11B ELC of Palm Beach Coalition 06/26/2017 07/01/2017
Reviewing
139 VPK OEL-VPK 20 ELC of the Big Bend Region Ceriified 04/04/2017 07/01/2017 06/30/2018
1596 VPK OEL-VPK 20 ELC of the Big Bend Region Terminated 05/26/2017 07/01/2017 06/30/2018 05/26/2017
157 VPK OEL-VPK 20 ELC of the Big Bend Region Terminated 06/26/2017 07/01/2017 03/02/2019 06/26/2017
180 VPK OEL-VPK 20 ELC of the Big Bend Region Not Eligible 05/24/2017 07/01/2017 06/30/2018
26723 SR Contract Lite OEL Terminated 04/05/2017 @® Download 01/10/2017 01/10/2018 04/04/2017
26731 SR Contract Lite QEL Certified 03/15/2017 @ Download 01/01/2017 01/01/2018
26788 VPK-SIS Contract Lite ELC of the Big Bend Region Certified 04/04/2017 @ Download 04/04/2017 06/30/2017
26804 VPK-SIS Contract Lite ELC of the Big Bend Region Terminated 06/26/2017 @® Download 05/18/2017 06/30/2017 04/28/2017

75



Managing Documents

Documents can be added to the Document Library for coalition review. The folder list within the Document Library
is standard for all providers, but coalitions have the ability to re-name or add new folders. Documents uploaded to
the Documents tab of the provider profile will also populate in the Document Library; however, documents
uploaded to the Document Library will not populate in the Documents tab of the provider profile.

Viewing/Uploading Documents
To view or upload documents in a folder, the provider portal user will click the View Files or Upload New File
button, respectively.

Document Library Management
170 ]
Folder List

Folder Name 'Hgﬂ“% Date Updated Updated By
Accreditation and j or Gold Seal (1 files) I ml 08/14/2016 OELAdmin
Contracts (f files] \ 3 Upiaad New Flie 10/262016 OELAdmin
Insurance Auto (1 files) 08/14/2016 OELAdmin
Insurance Liability (0 files) m 08222016 cel fo.ga+01@gmail. com
Insurance-Warker Comp {1 files) 08/14/2016 OELAdmin
License or Exemption (1 files] m 08/14/2016 OELAdmin
Miscellaneous (@ files) 08/14/2016 OELAdmin
Monthly Adjustment Request (0 files) 08/14/2016 OELAdmin
Monthly Classroom Transfer Forms (0 files) 08/14/2016 OELAdmin
Monthly Extended Absence Request (0 files) 08/14/2016 OELAdmin
Monthly Outstanding Parent Fee (0 files) 08/14/2016 OELAdmin
Monthly Reimbursement Report (0 files) 08/14/2016 OELAdmin
Monthly Sign in-out Sheet (0 files) 08/14/2016 OELAdmin
Monthly VPK Child Withdrawal Forms (0 files) 08/14/2016 OELAdmin
Provider Public Rate Sheet {0 files) 08/14/2016 OELAdmin
Uncategorized (0 files) 08/14/2016 OELAdmin
Unemployment Insurance (1 files) 09122016 OELAdmin
VPK Affidavit of Good Moral Character (0 files) 08/14/2016 OELAdmin
VPK Background Screenings (0 files) 08/14/2016 OELAdmin
VPK Curriculum (0 files) 08/14/2016 OFELAdmin
VPK Director Credentials (0 files) 08/14/2016 OELAdmin
VPK Enroliment Certificates (0 files) 08/14/2016 OELAdmin
VPK Instructor's Credentials {0 files) 08/14/2016 OELAdmin
W9 (1 files) 08/14/2016 OELAdmin

Document Library Management

=
Change Folder: Contracts A
Total Files: 1 Date Created: 10/25/2016

Folder Detail - Contracts

File Name Download Date Uploaded Uploaded By
Koala jpg 12/07/2016 ledbetter kiwanis@gmail com
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Add New File

Select a document to upload.

+ Select the folder from the drop down list to which you would like to upload a file to.
+ Click the Browse... button to browse your documents and select the one that you want to upload to the folder.
+ You may give a description to the file you are uploading.

Upload file to site: Jim's House of Learning 2

Select Destination Folder # Contracts v

Select File %

Attach your document.

Click the Atiach Selected Document button below to upload the selected document to your selected folder. This will
upload a copy of your document and store it in the chosen folder. The upload process may take from several
seconds to a minute, depending on the size of the document and the speed of you internet connection.

Attach Selected Document

Cancel
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Provider Portal users can move within the Document Library by clicking the Change Folder dropdown menu
can also be renamed within each folder by clicking the Rename File button.

. Files

Document Library Management

Change Folder: Contracts v

Total Files: 1 Date Created: 10/25/2016
Folder Detail - Contracts
File Name Download Date Uploaded Uploaded By

Koala.jpg 12/07/2016 ledbetter kiwanis@gmail.com

Enter the new file name in the New File Name field and click the Save Changes button to continue.

Rename File

Select Folder: Contracts

Select File: ‘ Koala jpg hd ‘

New File Name: |

Archiving Documents

Cancel Save Changes

Click the Remove button to remove a document from the profile documents screen and archive it in the
appropriate Document Library Management folder.
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Document Library Management

A Frequently Asked Questions pop-up message is available for the Provider Portal user. Contact the local early
learning coalition if additional help is needed.
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Provider Contracting

NOTE: Provider contracts are populated by information in the Active profile. As a result, the profile is read-only
once the contract status is Initiated, Incomplete, or Submitted. If any changes need to be made to the Active
profile after a contract is initiated or there is an error found in the profile once the contract is being edited (the

contract status is Incomplete), contact your early learning coalition.

SR Contract
After the coalition has initiated an SR contract, the user will navigate to Contracts > Manage Contracts from the

Provider Dashboard.

The Manage Contracts page displays. Click the Edit button for the initiated DEL-SR 20.

Manage Contracts

Show | 10 ~ entries £ Clear All Filters Search:

Contract View Termination Program
D Type of Contract Contract Name Coalition Status Last Updated Action Contract Effective Date Date Year

Filter Filter Filter Filter Filter Filter Filter Filter Filter Filter Filter
[——
n 113629 SR DEL-SR 20 ELC of Initiated 4/512023 TH1/2023 2023 - 2024
—




Provider Eligibility and Notification
After clicking the Edit button, the following page displays. Review the options in the dropdown menus and update
the provider representative information, if needed.

School Readiness (SR) Contract Return for Edit

Provider(s):
1 PRESCHOOL

II. PROVIDER ELIGIBILITY

Il.&.a The Cealition participates in the Contracted Slots Program. | Yes v

Il.&.c The COALITION has determined the PROVIDER eligible to participate in the Contracted Slots Program. | Yes v

I1l. PROVIDER RESPONSIBILITIES AND SCOPE OF WORK

111.30. If applicable, does the eligible PROVIDER, pursuant to paragraph 8, elect to participate in the Contracted Slots Program? #
XI.LNOTIFICATION

X183b The representative for PROVIDER for the purposes of this Contract is l:l # who can be contacted atl:l or by email at

| (@gmail.com

SIGNATURE AUTHORITY

Select all signature authority candidates that apply:

Select~

< Previous Step Next Step ¥

Provider Responsibilities and Scope of Work

If the provider is eligible to participate in the contracted slots program, the provider must select if they want to
participate in the program. If the contracted slots program is not applicable, the option to participate in the
contracted slots program is not displayed.

If this question is displayed, make a selection.
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Signature Authority

Providers must designate all users who are authorized to sign the SR contract for the listed provider(s).
Provider portal users who have full permissions to manage SR contracts are included in the dropdown.

NOTE: Users who also have coalition portal access (e.g. ELC, RCMA, and DEL users) are excluded from
the list as authorized provider signators.

Click the dropdown field to view all provider users who are eligible to electronically sign the SR contract.
Select all users who should have authorization to sign the contract for the listed provider(s).

NOTE: In order for the user who is currently editing the contract to be able to electronically sign, their
username must be selected.

When the authorized signator(s) are selected, click Next Step.

82



Exhibit 1: Program Assessments

After clicking the Next Step button, the Exhibit 1 page displays. If the provider is exempt from program assessment
requirements, the provider must select if they want to waive the exemption. If the provider is not exempt, the
option to waive exemption is not displayed.

NOTE: If the provider is exempt from program assessments and selects “Yes” to waive the exemption, the contract
will be sent back to the coalition for review.

The Composite Program Assessment Score displays under Provider Eligibility and is read-only.

School Readiness (SR) Contract Return for Edit

Exhibit 1
Provider Name:
PROVIDER ELIGIBILITY

The COALITION has determined the PROVIDER is exempt from the program assessment requirement pursuant to Rule 6M-4.740, FA.C. [No ~

Composite Program Assessment Score |3.99
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Exhibit 1: Child Assessments
On the Exhibit 1 page, select if the provider elects to conduct child assessments.

School Readiness (SR) Contract Return for Edit

Exhibit 1

Provider Name

PROVIDER ELIGIBILITY
The COALITION has determined the PROVIDER is exempt from the program assessment requirement pursuant to Rule 6M-4.740, FA.C. No ~

Composite Program Assessment Score | 3.99

PROVIDER RESPONSIBILITIES AND SCOPE OF WORK

If applicable, the eligible PROVIDER, agrees to conduct child assessments using a reliable assessor as defined by the child assessment tool, that meet the criteria described in s. 1002.82(k), F.5., at least three times
per year and will submit valid and reliable data to the statewide information system. If the PROVIDER selects to conduct child assessments, PROVIDER understands the requirements of the rule must be met to
receive the child assessment differential.

*[Salect v]

PROVIDER agrees to conduct child assessments in accordance with Rule 6M-4.500(11), FA.C. using the selected as the assessment tool.
NIA ~

< Previous Step Next Step *

If “Yes” is selected, a pop-up message appears for the provider to confirm that they have/will upload the reliability
certification.

© Confirm Child Assessment

You selected yes to indicate you wish to implement child
assessments. If you have not uploaded the required certificates of
reliability in the Quality Performance System (QPS) you must do 5o
immediately in order to proceed with your SR contract

By clicking "Yes" you certify that you have the reliability certification
and will be required to upload.
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If the provider selects “Yes” to conduct child assessments, select a child assessment tool. Click Next Step to
continue.

School Readiness (SR) Contract Return for Edit

Exhibit 1

Provider Name:

PROVIDER ELIGIBILITY

The COALITION has determined the PROVIDER is exempt from the program assessment requirement pursuant to Rule 6M-4.740, FAC. [No v

Composite Program Assessment Score |3.99

PROVIDER RESPONSIBILITIES AND SCOPE OF WORK

If applicable, the eligible PROVIDER, agrees to conduct child assessments using a reliable assessor as defined by the child assessment tool, that meet the criteria described in s. 1002.82(k), F.S., at least three times

per year and will submit valid and reliable data to the statewide information system. If the PROVIDER selects to conduct child PROVIDER 1ds the requil of the rule must be met to
receive the child assessment differential.
*

PROVIDER agrees to conduct child assessments in accordance with Rule 6M-4.500(11), FA.C. using the selected as the assessment tool.
—*

< Previous Step Next Step ¥
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Exhibit 3: Quality Improvement Plan Selection
After clicking Next Step, the Exhibit 3 page only displays if the provider is required to participate in a quality
improvement plan. Enter the user’s initials in each box that has a check mark, then click Next Step to continue.

School Readiness {SR) Contract

Return for Edit

Exhibit 3: Quality Improvement Plan Selection

Selection

]

Provider Initials

Teacher
Mame(s):

d

Provider Initials

Teacher
Name(s)

d

Provider Initials
Teacher
Mame(s):

Provider Initials

Teacher
Name(s)

Provider Initials

Teacher
MName(s):

See QIP Notice
Provider Initials

Teacher
Name(s).

Strategy

COALITION approved strategy

Cerlified Coaching Visits

CLASS Group Coaching (CEE)
Training

Early Childhood Training System
(ECTS) Courses

0-hours of IACET- or DEL-
approved Iraining

Professional Development

Description (summary)

Description included in QIP Nofice.

Each selected classroom will participate in 20 hours of certified coaching provided by the ELC or its delegate.

Each selected instructor/director will complete either the CGC PreK 24-hour course or the CGC Infant/Toddler 24-hour
course provided by the COALITION's or its delegate’s CGC Specialist

Each selected instructor/director will successfully complete two Early Childhood Training System courses facilitated by the
ELC. Course options include taking an online course alone. with TA coaching support andlor as a member of a COALITION-
sponsored Community of Practice.

Each selected instructoridirector will register for and successfully complete 20 hours of International Association for
Continuing Education & Training (IACET) approved training (or other DEL-approved CEU training) provided by the ELC or
their delegate.

Each selected instructoridirecior shall register in the Florida Early Care and Education Professional Development Registry,
generate a professional development plan in the registry and complete the required progression along the career pathway.

Next Step >
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Exhibit 5: Provider Reimbursement Rates
If the provider charges an annual registration fee (Profile > Provider Profile > Fees & Discounts), the following
page displays. Select the annual fee details, then click Next Step to continue.

NOTE: If “Month” is selected, another dropdown field appears for the provider to select a month. If “Other” is
selected, the provider must provide a description.
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Exhibit 6: Holiday Schedule
After clicking Next Step, the following displays. The dates are based on any coalition-defined holidays and the
closure dates from the profile Closure Calendar.

If fewer dates are listed than the coalition maximum total paid closure dates, additional provider holidays can be
added to the holiday schedule exhibit if applicable. Click the Edit button on the holiday table.

A pop-up window appears with an editable holiday table. On a blank row, enter the holiday name, then select a
date from the dropdown in the Date column. Duplicate dates cannot be used.

On a multi-site contract, if all sites have the same holiday schedule, select the box for “All sites use this holiday
schedule?” to complete Exhibit 1 for all providers.

When done editing, click Save. Then, click Next Step to continue.
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Preview Contract

Prior to executing the contract, click Preview Contract to view the contract. This allows the user to view all the
information input into the contract and exhibits from the profile. Information added by the coalition and provider
should be reviewed as well.

After clicking the Preview Contract button, the following displays in a new browser tab.

< oh of23 | ) © 100% v =

STATE OF FLORIDA
STATEWIDE SCHOOL READINESS PROVIDER CONTRACT
FORM DEL-SR 20

1. PARTIES AND TERMS OF CONTRACT

1. Parties. This Contract 1s made and entered into this _ Ist davof _July . 20_22 _byand
between the Early Learning Coalition of County_ (herein referred to as
“COALITION™), and LEARNING CENTER, INC
doing business as (if applicable), __Learning Center _ (herein

referred to as "PROVIDER™), with its principal offices located at
and its provider phvsical site address (if the single site
provider physical site address 1s different from principal office address) located at

a. Multiple Public School Locations. [f PROVIDER is a school district executing a single
Contract on behalf of multiple public school School Readiness (SR) Program
PROVIDERS, a list of their names and their physical addresses are included 1in Exhibit 1
PROVIDER Location List. Thereafter, PROVIDER shall mclude each location listed
Exhibit 1.

b. Multiple Private Locations. [f PROVIDER is executing a single Contract on behalf of
multiple private SR PROVIDER sites within COALITION'S service area, a list of their
names and their physical addresses are included in Exhibit 1: PROVIDER Location List.
Thereafter, PROVIDER. shall include each location listed in Exhibit 1.

c. Identification Number. Insert PROVIDER's [X] EIN or || SN here:

PROVIDER s EIN (Emplover Identification Number) or SSN (Social Securnty Number) 1s
requested in accordance with ss. 119.071(3)(a)2 and 119.092, F.S._| for use in the records
and data systems of the Division of Early Learning and COALITION. Submission of
PROVIDER s EIN or SSN 15 mandatory. PROVIDER s EIN or SSN will be used for
processing pavments to PROVIDER as an SR PROVIDER. for reporting those payments
for federal tax purposes, and for routine identification. [f PROVIDER completes Exhibit 1
listing multple locations with multiple EIN numbers, this paragraph may be left blank.

2. Purpose. This Contract 1s designed to inform PROVIDER of the requirements of participation

in the SR Program. Pavment 1s not conveved to PROVIDER through this Contract. Instead,
PROVIDER must agree to complv with the terms and conditions of this Contract in order to
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Contract Execution
To electronically sign the contract, check the By Electronic Signature checkbox.

NOTE FOR PUBLIC SCHOOLS: If a school board or school district needs to manually sign a contract, the contract can
be downloaded as a .pdf and printed. An authorized representative should electronically sign and submit the
contract.

After clicking the checkbox, the following message displays. Enter the Title, then click Yes.

NOTE: Be sure to enter the signatory’s business title in the pop-up (e.g., Owner, Director, Principal), not their
name.

After clicking the Yes button, the electronic signature of the signatory, printed name, title, and the date/time will
populate, highlighted in yellow. Click Next Step to continue.
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NOTE: The electronic signature and printed name of the user is based on the user who is logged on to the portal.
Please ensure that the proper user is logged on to electronically sign the contract. If the incorrect name is used for
the electronic signature, the checkbox can be un-checked.

© Form DEL-SR 20 Electronic Signature

You are about to remove your signature from the Form DEL-SR 20.

Click "Yes" to continue.
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Contract Certification
After clicking the Next Step button, the following page displays. Enter the full name of the user who is logged on,
title, and click the Certified by electronic signature checkbox. Click Submit.

SR Contract Certification

In accordance with 5. 1002.88(1)(p), F.S.. PROVIDER has caused this Contract to be executed as of the date set forth in Paragraph 1. By signing below, PROVIDER hereby certifies that PROVIDER has read and
understood this Contract. PROVIDER certifies that all information provided is true and correct and agrees that noncompliance with the requirements of the School Readiness Program including, but not limited to the
requirements of this Contract, and all Exhibits and authorized attachments, shall result in corrective action, withholding of funds, or termination of this Contract at the discretion of COALITION, in accordance with
Section X.

Warranty of Authority. Each person signing this contract warrants that he or she is duly authorized to do so and to bind the respective party to the contract

By signing this form | certify that:

| had the opportunity to review the Statewide School Readiness (SR) Provider Contract.

I have examined this contract and, to the best of my knowledge and belief, the information
provided is true and correct.

I understand that upon the approval of my provider's contract, | will receive notification my
contract is in force.

I am duly authorized to sign and bind the respective party to the contract.

Submit Contract

# Full Name

# Title

* .Zeniﬂed by electronic signature
Contract sign date 4152023
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After clicking the Submit button, the following message will display, and an email will be sent by
DONOTREPLY@OEL.myflorida.com.

15 You Have Successfully Completed, Signed, Certified and Submitted your Statewide SR Provider Contract!
Your early learning coalition will review and process your contract.

Please check your email for important information regarding your contract.

*You can click on the button below to return to your home page.

4 Retum to home page

Navigate to the provider manage contracts page (Contracts > Manage Contracts). The SR contract will have a
status of Submitted for the coalition to review.

B Manage Coniracis

Show| 10 v entries £ Clear All Fitters Search:

Contract View Termination Program
D IF | Type of Contract Contract Name Coalition Last Updated Action Contract Effective Date Date Year

Filter Filter Filter Filter Filter Filter Filter Filter Filter Filter Filter
T
n 113626 SR DEL-SR 20 ELC of Submitted 4152023 7172023 2023 - 2024
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VPK Contract
After the coalition has initiated a VPK contract, the user will navigate to Contracts > Manage Contracts from the
Provider Dashboard.

The manage contract page displays. Click the Edit button for the initiated DEL-VPK 20.

Manage Contracts
Show 10 v entries & Clear AllFilters [

Contract Type of View Termination Program
D 1¥ | contract Coalition Last Updated Contract Effective Date Date Year

Filter Filter Filter Filter Filter Filter Filter Filter Filter Filter Filter
n 113609 VPK DEL-VPK 20 ELC of Initiated 41412023 7112023 2023 - 2024
TALLAHASSEE

94



Compensation and Funding: Advance Pay Options
After clicking the Edit button, the following page displays. When the user’s pointer hovers over the dropdown
fields, a tool tip informs the user that the advance payment selections will apply to all sites on the contract.

Select an Advance Payment Option for the school year and summer programs. Click Next Step to continue.

School Year Program

Select

PROVIDER elects to receive monthly advance payments for the school year program.
PROVIDER elects not to receive monthly advance payments for the school year program.
PROVIDER does not intend to offer the school year program.

Summer Program

Select

PROVIDER elects to receive monthly advance payments for the summer program.
PROVIDER elects not to receive monthly advance payments for the summer program.
PROVIDER does not intend to offer the summer program.
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Exhibit 1: Provider Location List Attachment
After clicking the Next Step button, the following displays. Select the School Year and/or Summer checkbox if the
session is offered. Click Next Step to continue.

Preview Contract

Prior to executing the contract, click Preview Contract to view the contract. This allows the user to view all the
information input into the contract and exhibits from the profile. Information added by the coalition and provider
should be reviewed as well.
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After clicking the Preview Contract button, the following displays in a new browser tab.

< < h of7 P > O © 100% v =

STATE OF FLORIDA
STATEWIDE VOLUNTARY PREKINDERGARTEN
PROVIDER CONTRACT
FORM DEL-VPK 20

I PARTIES AND TERMS OF CONTRACT

1. Parties. This Contract 1s made and entered into this _ 1st dayof _July _20_23 by and
between the Early Learning Coalition of _ TALTAHASSEE  (herein referred to as
“COALITION™), and _ Ventura Prod Provider Test 2 {(doing business as, if applicable)
Ventura Day School  (herein referred to as “PROVIDER™), with its principal offices located at __
2 Esplanade Way Tallahassee, FL 32311  and its provider physical site address (if the single
site provider phyvsical site address 1s different from principal office address) located at __ 1
Shumark Oak Dr Tallahassee, FT 32311 .

a. Multiple Public School Locations. [f PROVIDER i1s a school district executing a
single Contract on behalf of multiple public school Voluntary Prekindergarten (VPK)
Education Program providers, a list of their names and their phvsical addresses are
mcluded in Exhibit 1: Provider Location List. Thereafter, PROVIDER. must include
each entity listed in Exhibit 1.

b. Multiple Private Provider Locations. If PROVIDER 1s executing a single Contract on
behalf of multiple private VPK provider sites within COALITION s service area, a list
of their names and their physical addresses are included 1n Exhibit 1: Provider Location
List. Thereafter, PROVIDER must include each entity listed in Exhibit 1.

c. Identification Number. Insert PROVIDERs [X| EIN or [ SSN
here: _ 183387243

PROVIDER s EIN (Emplover [dentification Number) or S5N (Social Security
Number) 1s requested 1n accordance with ss. 119.071(5)(a)2. and 119.092, F.S__ for use
in the records and data systems of the Division of Early Learning and COALITION.
Submission of PROVIDER s EIN or S5N 1z mandatory. PROVIDER s EIN or SSN wall
be used for processing pavments to PROVIDER as a VPK prowider, for reporting those
pavments for federal tax purposes, and for routine identification. If PROVIDER
completes Exhibit 1 lListing multiple locations with mulitiple EIN numbers, this
paragraph may be left blank.

2. Purpose. This Contract 1s designed to inform PROVIDER of the requirements of participation
in the VPK Program. Payment is not conveved to PROVIDER through this Contract.
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Contract Execution
To electronically sign the contract, click the By Electronic Signature checkbox.

NOTE FOR PUBLIC SCHOOLS: If a school board or school district needs to manually sign a contract, it can be
downloaded as a .pdf and printed.

After clicking the checkbox, the following message displays. Enter the Title, then click Yes.

NOTE: Be sure to enter the signatory’s business title in the pop-up (e.g., Owner, Director, Principal), not their
name.
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After clicking the Yes button, the electronic signature of the signatory, printed name, title, and the date/time will
populate, highlighted in yellow. Click Next Step to continue.

NOTE: The electronic signature and printed name of the user is based on the user who is logged on to the portal.
Please ensure that the proper user is logged on to electronically sign the contract. If the incorrect name is used for
the electronic signature, the checkbox can be un-checked.

© Form DEL-VPK 20 Electronic Signature

You are about to remove your signature from the Form DEL-VPK 20.

Click "Yes" to continue.

Cancel
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Contract Certification
After clicking the Next Step button, the following will display. Enter the full name of the user who is logged on,
title, and click the Certified by electronic signature checkbox. Click Submit.

& VPK Col

In accordance with ss. 1002 55(3)(i), 1002.61(3)(b), and 1002.63(3)(b), F.5., PROVIDER has caused this Contract to be executed as of the date set forth in Paragraph 1. By signing below, PROVIDER hereby certifies that
PROVIDER has read and understood this Contract. PROVIDER certifies that all information provided is true and correct and agrees that noncompliance with the requirements of the VPK Program, which include the requirements
of this Contract, and all Exhibits and authorized attachments, shall result in corrective action, withholding of funds, or termination of this Contract at the discretion of COALITION, in accordance with Section X

Warranty of Authority. Each person signing this contract warrants that he or she is dually authorized to do so and to bind the respective party to the contract

By signing this form | certify that:

I'had the ity to review the ide Voluntary Preki (VPK) Provider
Contract.

I have examined this contract and, to the best of my knowledge and belief, the information
provided is true and correct.

| understand that upon the approval of my provider's contract, | will receive nofification my
contract is in force.

| am duly authorized to sign and bind the respective party to the contract.

Submit Confract

% Full Name

¥ Title

e
* @r{iﬂad by electronic signature

Contract sign date

4/42023

After clicking the Submit button, the following message will display, and an email will be sent by
DONOTREPLY@OEL.myflorida.com.

5 You Have Successfully Completed, Signed, Certified and Submitted your Statewide VPK Provider Contract!
Your early learning coalition will review and process your contract.

You may not offer VPK services until you have received notification that your contract has been approved and fully executed by your coalition.

Please check your email for important information regarding your contract.

You can click on the button below to return to your home page.

4 Retum to home page
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Statewide VPK Provider Contract Submitted inbex x

NoReplyCoalitionPortal@del.fldoe.org Jan 26, 2023, 2:30PM

to jenniferventura.prod+testprovider2 -

Hello Jaycie Ventura.

The Statewide VPK Provider Contract (Forms OEL-VPK 20, 20PP/PS) you submitted for Ventura Prod Provider Test 2 has been delivered to
the ELC of TALLAHASSEE. The contract will be reviewed and you will receive an email with further instructions.

Remember, you must receive a copy of the Statewide VPK Provider Contract signed by the coalition before receiving payment or
beginning VPK classes.

Thank you,

ELC of TALLAHASSEE

(850) 555-5554
hittp://floridaearlylearning.com

Please do not reply to this message. Replies to this message are routed to an unmonitored mailbox. If you have questions, please contact
your early learning_coalition .

Navigate to the provider manage contracts page (Contracts > Manage Contracts). The SR contract will have a
status of Submitted for the coalition to review.

B Manage Contracts

Show

10

Contract View Termination Program
D I¥ | Type of Contract Contract Name Coalition Last Updated Contract Effective Date Date Year

“ 113609

£3 Clear All Filiers  [SSEEIRH

Filter Filter Filter Filter Filter Filter Filter Filter Filter

DEL-VPK 20 ELC of TALLAHASSEE 4142023 71i2023 2023 - 2024
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VPK-APP

The VPK-APP replaces forms DEL-VPK 10 (Provider Application), DEL-VPK 11A (Class Registration — Instructors), and
DEL-VPK 11B (Class Registration — Calendars). The tabs must be done in order of appearance (Attendance Policy,
then VPK Director, etc.); the answers in one tab populate information in the next tab.

After the coalition has initiated the provider application, the Provider Portal user will click Manage Contracts from
the Provider Dashboard.

The following will display. Click the Edit button to review the contract.

Contract ID 13 Type of Contract Contract Name Coalition Last Updated Action View Contract Start Date End Date Temination

Date
44 VPK-APP VPK 10,11A 118 ELC of North Florida/Episcopal Initiated 412012017 7172017
Children's Services

Step 1 — Attendance Policy

The Attendance Policy tab allows the Provider Portal user to upload the provider Attendance Policy. The document
that is to be distributed to parents must be uploaded by clicking the Browse button, finding the document in the
electronic files and clicking the Upload button.
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Step 2 — VPK Director
The VPK Director tab allows the Provider Portal user to add information and upload documents for the primary
VPK Director that will be listed on the DEL-VPK 10. Click the Add New Director button to begin.

Click the Save button after all information is entered for the director.

NOTE: The Credential Type, Credential Certificate Number, Credential Issue Date, and Credential Expiration Date
will not appear for public schools.

Once the VPK Director is added, the supporting documents may be added by clicking Edit.
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The Provider Portal user will select the document type, browse to select a file, enter the document issue or
expiration date (if applicable), and click Upload. Then, click Save. At least one document should be uploaded.

Step 3 — VPK Instructors
The VPK Instructors tab allows the Provider Portal user to add information and upload documents for each
instructor. Click the Add New Instructor button to begin.

Click the Save button after all information is entered for each instructor.
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Once the VPK Instructor is added, the supporting documents may be added by clicking Edit.

The Provider Portal user will select the document type, browse to select a file, enter the document issue or
expiration date (if applicable), and click Upload. Then, click Save. At least one document should be uploaded.

NOTE: If a VPK Instructor achieves new certifications and moves from a sub to an aide, create a new record for
that Instructor. If the Instructor Type is only changed from sub to aide, the maximum class size will not increase to
20 in a class that already has a Lead Instructor.

Step 4 — VPK Calendars

The VPK Calendars tab allows the Provider Portal user to provide information regarding each unique class calendar
which will be offered at the VPK site. If classes are offered at identical times on identical dates, they utilize the
same class calendar (e.g., all classes are scheduled from 8:00am to 11:00am, Monday through Friday, starting on
January 11). If classes are not offered at identical times on identical dates, they utilize unique class calendars which
must be created separately. Click the Add New Calendar button to begin.

The Calendar ID will automatically populate with a letter beginning with A. Each additional calendar will receive a
sequential Calendar ID.

The Calendar Name is an optional field. It may be used for a short nickname such as “Fall AM.”

106



The program type selection of School-Year (540 hours) or Summer (300 hours) is required. The program selected
will determine the valid calendar date range. The Calendar Start Date and Calendar End Date must be within the
valid calendar date range. The Calendar Start Date and Calendar End Dates should reflect the first day VPK
instruction will be delivered and the final day VPK instruction will be delivered.

Next, the instructional days, start time and end time must be added by checking the box by the days of the week
that VPK instruction will be delivered and entering the times of VPK instruction for the days of the week that VPK
instruction will be delivered.

After the instructional days, start time and end time are added, the Total Calculated Hours and Total VPK
Instructional Days sections will populate.

Providers are to use the calendar to note any non-instructional days on which VPK instruction will not be delivered
(such as vacations or holidays) and exceptions to normal instructional days that occur during the defined calendar
start and end date. Entering Non-Instructional Days and Instructional Day Exceptions can increase or decrease the
Total Calculated Hours. A calendar day can have only one Event Type: Instructional Day Exception or Non-
Instructional Day. Additionally, a calendar day cannot have more than one Instructional Day Exception.
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For example, if the Total Calculated Hours exceed 300 hours for the summer program type or 540 hours for the
school-year program type (as shown in the example above), the user may remove a day (or more) by labeling it a
Non-Instructional Day. Each Non-Instructional Day entered will deduct the hours assigned to that day, thereby
decreasing the Total Calculated Hours. Instructional Day Exceptions can be used to change the hours assigned to
that day (to increase or decrease the hours). For example, if the calendar is a few hours short, an instructional
day’s hours may be extended to increase the Total Calculated Hours. To add a Non-Instructional Day or an
Instructional Day Exception to the calendar, click on that date on the calendar. Multiple days can be selected by
clicking and dragging across multiple days on the calendar.

N

After clicking on a date, a pop-up message will appear. The Provider Portal user must select the Event Type and
enter a short description. When an Instructional Day Exception is selected, the user must also enter the time range

for the day.

Modify VPK Instructional Day

Event Type: @

Non-Instructional Day
Instructional Day Exception

Description:

—

Click the Update button to save changes. Click the Remove button to remove an existing Non-Instructional Day or
Instructional Day Exception created on the calendar.
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When the Total Calculated Hours match the hours for the VPK program type, the user will click the Save button.

NOTE: The hours must equal, or be fewer than, 300 hours for the summer program type or 540 hours for the
school-year program type for the calendar to save.
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Step 5 — VPK Class(es)
The VPK Class(es) tab allows the Provider Portal user to build VPK classes and assign instructor(s) to them. Click the
Add New Class button to begin.

The Class ID will automatically populate after the Class Calendar is selected. The Class ID is created using a
sequential letter beginning with A. In the second space, either an “F” for school-year (fall) or “S” for summer will
appear. The Fand S is derived from the calendar’s program type. The last two digits represent the last two
numbers of the program year. Each additional class will receive a sequential Class ID.

The Class Name is an optional field. It may be used for a short nickname such as “Blue Room.”

The Main Curriculum drop down is populated with selections made from the provider’s profile.

The Class Start Date and Class End Date are populated with the Calendar Start Date and End Date.

The Instructors are populated with individuals from the VPK Instructors tab. Check the checkbox in front of the
instructor to add them to the class, then enter the Instruction Start Date. If the class has not started, the
Instruction Start Date defaults to the Class Start Date. For each class, one Lead Instructor must be selected. Click
the Save button after all information is entered for each class.

Class ID: &

Class Name: @
Class Calendar: &
Main Curriculum: &
Class Start Date: &
Class End Date: @

Instructors:

| Save Cancel

CF17

Enter Class Name

A-1

BABY DOLL CIRCLE TIME
01/01/2018 E
D6/292018 =

& .im Ledbetter (Received an M.A. or an M.S, Lead, M.A. or M.S. in an approved field with required minimum hours and experience )

Instruction Start Date: 01012018 -

O Mot Jim Ledbetter (Received an M_A_ or an M5, Lead, M_A_ or M.S. in an approved field with required minimum hours and experience )
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Step 6 — Review

During the review process, the Provider Portal user can click the Edit button to make any changes to a section.
After reviewing the information for each section, the user must click the Certify and Submit tab button to
continue.
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Step 7 — Certify and Submit
To submit the VPK-APP, the Signer’s Name must exactly match the name entered in the Provider Profile, the

Provider Portal user must fill in the phone number, check the “Check box to certify by electronic signature” check
box and click the Submit VPK Provider Application button.

1> You Have Successfully Completed and Submitted your VPK Provider Application!

Congratulations, you have successfully submitted your VPK Provider application.
Your early learning coalition will process your application.

Please check your email for important information about your application.

From here you can:

Return to dashboard

Log off
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VPK-APP for Ownership Change

If a provider has undergone a change of ownership, as indicated during their provider account registration, the
initiation of a new VPK-APP under the new provider ID will copy over the most recently certified VPK-APP from the
old Provider ID. This copy over will be indicated by the Ownership Change icon on the VPK-APP.

Additionally, text will be displayed on the sections of the VPK-APP to indicate the previous provider site from which
the VPK-APP sections were copied.

VPK-APP for Location Change

If a provider has undergone a change in physical location, as indicated on the Add Site page of the Manage All
Sites page, the initiation of a new VPK-APP under the new provider ID will copy over the most recently certified
VPK-APP from the old Provider ID. This copy over will be indicated by the Address Change icon on the VPK-APP.

Additionally, text will be displayed on the sections of the VPK-APP to indicate the previous provider site location
from which the VPK-APP sections were copied.
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Updating a VPK-APP
A Provider Portal user can edit a VPK-APP by clicking the Edit button on their Manage Contracts page. Clicking the
Download button will export the information in the VPK-APP to a .pdf document.

Manage contracts for Jim's House of Canes & Gators (gtotal records

Show 10 entries -

Contract ID }} Type of Contract Contract Name Coalition Status Last Updated Action View Contract Start Date End Date Termination
Date
45 VPK-APP VPK 10,11A,11B ELC of Palm Beach Certified 06/27/2017 07/01/2017 0711712018
—

VPK Director

To edit the current director’s information in the VPK Director tab, click the Edit button. To remove a director, click
the Remove button. To add a new director, click the Add New Director button. To edit the current supporting
document, or add a new document, click the Edit button.

]
] -

When the Remove button is clicked, the following message will display.

Remove Mot Jim Ledbetter?

© You are about to remove this director and make him/her inactive. All information
and documents (if any) will be retained. You may re-add this director at a later time if
needed. To continue, enter the last day this individual served as VPK Director and
click Remove, otherwise click Cancel.

Enter or Select Date =t

| ‘ Cancel

Once the director’s last day is entered and the Remove button is clicked, the director will no longer appear on the
VPK Director screen, unless the Show removed directors checkbox is checked. The director can be re-added by
clicking the Re-add button.
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VPK Instructors

To edit the current instructors’ information in the VPK Instructors tab, click the Edit button. To add a new
instructor, click the Add New Instructor button. To remove an instructor, click the Remove button. To edit the
current supporting document(s), or add a new document, click the Edit button.

]
] -

If the instructor has not been assigned to a class, when the Remove button is clicked, the following message will
display.

¥ Remove Not Jim Ledbetter?

® *vou are about to remove this instructor and make him/her inactive. All information
and documents (if any) will be retained. You may re-add this instructor at a later time if
needed. To continue, click Remove, otherwise click Cancel.

Cancel Remove
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Once the Remove button is clicked, the instructor will no longer appear on the VPK Instructors screen, unless the
Show removed class instructors checkbox is checked. The instructor can be re-added by clicking the Re-add
button.

If the instructor has been assigned to a class, when the Remove button is clicked, the following message will
display.

@ Intructor is currently assigned

© This action cannot be performed because the instructor is currently assigned to a
class. Please remove the instructor from all classes first.

Ok

To remove an instructor from a class, go to the VPK Class(es) section and click the Edit button for the class.

O
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In the Instructors area, uncheck the instructor’s name. Once un-checked, enter the Last Taught Date, or click the
Never began instruction of class checkbox if the class has not started. Click Save.

Class ID: @ CF17
Class Name: €@ Enter Class Name
Class Calendar:
Main Curriculum:

BABY DOLL CIRCLE TIME v

Class Start Date:

[}
[}
e 01/01/2018
[}

Class End Date: 06/29/2018

Instructors:

& Jim Ledbetter (Received an M.A. or an M.S, Lead, MA. or M.S. in an approved field with required minimum hours and experience )

Instruction Start Date: 01/01/2018

O Not Jim Ledbetter (Received an M.A. or an M., Lead, M.A. or M.S. in an approved field with required minimum hours and experience )

Last Taught Date: 02/22/2018 = [O Never began instruction of class ]

Cancel

The VPK Classes tab will now show that the instructor is removed from the class.

)

Now that the instructor is no longer assigned to any class, the Provider Portal user may go to the VPK Instructors
tab to remove the instructor by clicking Remove. The following message will display:

X Remove Not Jim Ledbetter?

© You are about to remove this instructor and make him/her inactive. All information
and documents (if any) will be retained. You may re-add this instructor at a later time if
needed. To continue, click Remove, otherwise click Cancel.
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Once the Remove button is clicked, the instructor will no longer appear on the VPK Instructors screen, unless the
Show removed class instructors checkbox is checked. The instructor can be re-added by clicking the Re-add
button.

The Review tab is also updated with the Instructor removal information.
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VPK Calendars

To edit the current calendar in the VPK Calendars tab, click the Edit button, make any necessary edits, and click the
Save button. To remove a calendar, click the Remove button. To add a new calendar, click the Add New Calendar
button.

—
]

O

If there are no classes assigned to a calendar, when the Remove button is clicked, the following message will
display.

Remove 7

© You are about to remaove this calendar and make it inactive. You may re-add this
calendar at a later fime i needed. Are you sure you want to remove this calendar?

CEIN:E|| Remowe I

If there are classes assigned to a calendar, the following message will display:

@ Calendar is currently assigned

© This action cannot be performed because the calendar is currently assigned to a
class. If the class has not started yet, you may remove the calendar from the class
and try this action again.

Ok
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Once a calendar is removed, the calendar will no longer appear on the VPK Calendars screen, unless the Show
removed calendars checkbox is checked. The calendar can be re-added by clicking the Re-add button.

NOTE: Calendar End Dates and Class End Dates are editable.

The Calendar End Date can be changed to reflect changes in Non-Instructional Days or holidays that are added
after the calendar begins. Changing the Calendar End Date will update the Class End Date and the Instructor Last

Taught Date.
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After the calendar is changed, if the provider needs to change the Instruction Start Date of an instructor, the
provider will un-check and re-check the checkbox for each instructor and edit the date.
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The Calendar Name can be added if the provider did not add a Calendar Name when the calendar was created.
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VPK Class(es)

To edit the current class information in the VPK Class(es) tab, click the Edit button. To add a new class, click the
Add New Class button. To remove a class, click the Remove button. After all edits have been made for each class,
click the Save button.

)
]

Save Cancel

Classes that have started may not be removed. Limited editing is available.
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If the class has not started, when the Remove button is clicked, the following message will display:

Remove ?

O Are you sure you want to remove this classroom?

Cancel Remove

Once the Remove button is clicked, the class will no longer appear on the VPK Class(es) screen, unless the Show
removed classes checkbox is checked.

)
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To end the class, click the Edit button and the change the Class End Date to reflect the last day that VPK instruction
was provided. The Instructor Last Taught Date will be updated to the Class End Date after clicking the Save button.

Class ID: @ CF17
Class Name: @ Enter Class Name
Class Calendar: € A-1 Y
Main Curriculum: € BABY DOLL CIRCLE TIME v
Class Start Date: @ 01/01/2018
Class End Date: @ 02/22/2018

Instructors:

& Jim Ledbetter (Received an M.A. or an M.S, Lead, M.A. or M.S. in an approved field with required minimum hours and experience )

Instruction Start Date: 01/01/2018

Save | Cancel

The Review tab will now reflect the updated class information.
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Editing an SR Contract Amendment

Navigate to Contracts > Manage Contracts.

The Manage Contracts page for the provider site displays. Click the plus “+” sign to the left of the DEL-SR 20
contract to expand the amendment section. The Edit button is available when the amendment is in one of the
following statuses:

e Initiated

e Rejected

o Incomplete

Click the Edit button.

NOTE: If the amendment status is Initiated or Rejected, the status changes to Incomplete while the amendment is
being edited.
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Review the Provider(s), Provider Eligibility, Notification, and Signature Authority sections.
e PROVIDER RESPONSIBILITIES AND SCOPE OF WORK — If applicable, the contracted slots question displays.
Select a response.
e NOTIFICATION — Enter any changes to the provider contact information, if applicable.
e SIGNATURE AUTHORITY — If any changes are needed to the existing signature authority selections, click
the dropdown menu. Select all users who are authorized to sign contracts and amendments. To remove a
Signator, deselect the user(s) to be removed.

NOTES:
e Any previously selected users should remain selected if they are still authorized signatories.
e Users with coalition portal aces will not be on the authorized signators list.

Click Next Step to proceed to the Exhibit 1 page.
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Below is an example of an amendment for a multi-site provider where a new site is being added to the contract.
The page displays both providers currently on the contract and the new site being added to the contract.

Original Provider
e  PROVIDER ELIGIBILITY — If applicable, the provider can change their selection to waive their exemption

from Program Assessments.
NOTE: If the provider is answering the question for the first time, a response (Yes or No) is required.

e PROVIDER RESPONSIBILITIES AND SCOPE OF WORK — If a change is needed to the provider’s selection to
conduct child assessments (ONLY during the appropriate child assessment period) or the child assessment
tool needs to be changed, make the new selections and enter the reason for modification.

Added Provider
If a provider is being ADDED to the contract:

e PROVIDER ELIGIBILITY
0 If the provider is exempt from Program Assessment requirements, select if the provider wants to

waive their exemption and receive a program assessment.
o  PROVIDER RESPONSIBILITIES AND SCOPE OF WORK — Select if the provider conducts child assessments. If
yes, select the assessment tool.

Click Next Step to continue.
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The Exhibit 3: Quality Improvement Plan (QIP) Selection page displays if the coalition selected a new QIP strategy.
If Exhibit 3 displays, initial the selected strategy. Then, click Next Step.

SR Amel ient Quality Improvement Plans Preview Amendment

Exhibit 3: Quality Improvement Plan Selection

Provider Name: S
Selection Strategy Description (summary)
[w]

Provider Initials cOALITION approved strategy ~ Description included in QIP Notice

Teacher
Name(s)
8]

Provider Initials ¢orifieq Coaching Visits Each selected classroom will participate in 20 hours of certified coaching provided by the ELC or its delegate.

Teacher
Name(s)

nitials

CLASS Group Coaching (CGC)  Each selected instructor/director will complete either the CGC PreK 24-hour course or the CGC Infant/Toddler 24-hour
Teacher  Training course provided by the COALITION's or its delegate’s CGC Specialist.
Name(s)
See QIP Notice
o

Each selected instructor/director will successfully complete two Early Childhood Training System courses faciltated by the
ELC. Course options include taking an online course alone, with TA coaching support andior as a member of a COALITION-

Provider Iniials Early Childhood Training System
& sponsored Community of Practice.

CTS) Courses
Teacher
Name(s)
o
Each selected i will register for and complete 20 hours of International Association for

Continuing Education & Training (IACET) approved training (or other OEL-approved CEU training} provided by the ELC or
their delegate.

Provider Initials 20-hours of IACET- or OEL-
approved training
Teacher
Name(s)
o

Provider Initals ) Each selected instructordirector shall egister in the Florida Early Care and Education Professional Development Regstry,
Professienal Development A > A . >
generate a professional development plan in the registry and complete the required progression alang the career pathway.
Teacher

Name(s)

< Previous Step

The Exhibit 6: Holiday Schedule page displays. Click the Edit button to add or remove holidays, if applicable.
NOTE: Coalition paid holidays cannot be edited by the provider.
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To save your changes, click Save in the edit window, then click Close to close the window. Click Next Step to
proceed.

On the Amendment Signatures page, click the Preview button to review the DEL-SR 20A form to verify changes
before signing and submitting the amendment. Click the “By Electronic Signature” box to electronically sign the
amendment
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Enter the signatory’s business title in the pop-up (e.g., Owner, Director, Principal), not their name. Then click Yes to
proceed with electronically signing the amendment. Click Cancel to close the window without signing.

NOTE: To add an additional signature, click Cancel and have the other signator log in with their username to sign
the amendment before submitting. To remove the provider’s signature before submitting the amendment,
deselect the “By Electronic Signature” box and click Yes in the confirmation pop-up window.

When Yes is clicked in the pop-up window, the signator’s signature, printed name, title and the date are populated
and saved. Click Submit to proceed.

School Readiness (SR) Amendment Preview Amendment

Amendment Signatures

Click the check box to sign electronically. After signing, click Next to proceed to the submission page.

(Efectronic Signatura)

of i Vi i Officer/Owner/Princi Other

Authorized Representative Print Name
By Electronic Signature
Director 6/27/2021 8:48:24 PM
Title Date
Provider’s Additional Signatory (If required by the Provider) Print Name
By Electronic Signature
Title Date

‘COALITION has caused this Contract to be executed as of the date set forth in Paragraph 1

signature of Authorized Coalition Representative Print Name
By Electronic Signature

Title Date

Signature saved successfully.

S Felsse
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On the SR Amendment Certification page, enter Full Name and Title, then click the “Certified by electronic
signature box.” Click Submit to submit the amendment to the coalition.

& SR Amendment Certification

< Previous Step

The effective date of the Amendment shall be the date that it is signed by both parties. All previsions in the contract and any attachments/exhibits in cenflict with this amendment shall be and are hereby changed to conform to this
Amenament. All provisions not in conflict with this Amendment are stil in full force and effect in accordance with its terms and are to be performed at the level and in the manner specified in the contract.

IN WITNESS WHEREOCF, the parties have caused this Amendment to be executed by their proper and duly authorized representatives.

Warranty of Authority. Each person signing this Amendment warrants that he or she is dually authorized to do s0 and to bind the respective party fo the amendment

By signing this form | certify that:

« I had the opportunity to review the to the ide School (SR)

Provider Contract.

= | have examined this amendment and, to the best of my and belief, the il

provided is true and correct.

= | understand that upon the approval of my provider's | will receive i ion my

amendment is in force.

- lam duly authorized to sign and bind the respective party to the amendment.

Submit Amendment

* Full Name

* Tite Director

* Certified by electronic signature
Amendment sign date 612712021

A message that you have successfully completed, signed, certified, and submitted your SR amendment displays.

Navigate to Contracts > Manage Contracts to view the submitted amendment. Click the plus “+” sign to the left of
the DEL-SR 20 contract to expand the amendment section. The amendment is in Submitted status. Click the View
button to preview the amendment in a new browser tab.

Manage Contracts

Show 10 ~ entries

Filter
\ 83406 |
Amendment ID

18461

Show 10 v entries

Contract Termination Program
D 1¥ | Type of Contract Contract Name Coalition Last Updated Date Year

Filter Filter Filter Filter
Certified 6127/2021
1& stawus 11 Document

Submitted
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72021 2021 -2022

11 Action i)

First | Previous - Next = Last



\ Filter Filter Filter Filter Filter Filter Filter Filter Filter Filter Filter

Viewing a Certified SR Contract Amendment
After the coalition certifies the SR amendment, navigate to Contracts > Manage Contracts.

The Manage Contracts page displays. Click the plus “+” sign to the left of the DEL-SR 20 contract to expand the

amendment section. The amendment is in Certified status.

To download a PDF of the certified DEL-SR 20A and any associated exhibits, click the Download button.

Manage Contracts
Show 10w entries £ Clear All Filters  [JSEEUSIS

Contract View Termination Program
D IF | Type of Contract Coalition Last Updated Contract Effective Date Date Year

* 83406 SR OEL-SR 20 Certified 6/27/2021 71112021 2021 - 2022

Show 10 v entries

Amendment ID I£ Status It View I1 Document 11 Action 1t
18461 Certified

First | Previous - Next  Last
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Editing a VPK Contract Amendment

Navigate to Contracts > Manage Contracts.

The Manage Contracts page for the provider site displays. Click the plus “+” sign to the left of the DEL-SR 20
contract to expand the amendment section. The Edit button is available when the amendment is in one of the
following statuses:

e Initiated
e Rejected
o Incomplete

Click the Edit button.

NOTE: If the amendment status is Initiated or Rejected, the status changes to Incomplete while the amendment is
being edited.
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The Compensation and Funding page displays. The advance payment selections default to the selections on the
VPK contract or latest amendment. If a change is needed, select the new advance payment option for the school
year and/or summer programs. Click Next Step to continue.

NOTE: For VPK contracts with multiple sites, changing the advance payment selection will affect all sites on the
contract. If you are a provider on a multiple-site contract and you intend to change the advance payment
selection(s) for specific sites, but not all, contact your coalition to remove those sites from the contract. A separate
VPK contract will need to be executed for the provider sites that are removed from the contract.

If one or more provider is being added to the contract, the Exhibit 1: Provider Location List Attachment displays.
Select the box for school year and/or summer if the provider will offer the session, then click Next Step.
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The Amendment Signatures page displays. To preview the DEL-VPK 20A form, click Preview Amendment.

The DEL-VPK 20A loads in a new browser tab.

137



Exhibit 1 is generated for multiple-site providers as needed:

Exhibit 1: Provider Location List

Provider Name:

Changed?
Location Number
Location Legal Name
Doing Business As Name
Physical Address
Emplover Identification Number | 732368371
School Year | Yes
Summer | Yes
Composite Program Assessment Score | 3.51
Official Use Only | - Added Yes
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To sign the amendment electronically, on the Amendment Signatures page, click the box for the provider
authorized representative.

When the electronic signature box is checked, a pop-up window displays. Enter the signatory’s business title (e.g.,
Owner, Director, Principal), not their name. Then click Yes to proceed with electronically sighing the amendment,
or click Cancel to close the window without signing.
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When Yes is clicked, the signator’s signature, printed name, title and the date/time are populated and saved. Click
Submit.

To remove the provider’s signature before submitting the amendment, unselect the By Electronic Signature box
and click Yes in the confirmation pop-up window.

NOTE: To add an additional signature, have the other Signator log in to sign the amendment before submitting.

When the Submit button is clicked on the signatures page, the VPK Amendment Certification page displays. Enter
Full Name and Title, and click the “Certified by electronic signature box.” Click Submit.

# VPK Amendment Certification

The effective date of the Amendment shall be the date that it is signed by both parties. All provisions in the contract and any attachments/exhibits in conflict with this amendment shall be and are hereby changed to conform to
this Amendment. All provisions not in conflict with this Amendment are still in full force and effect in accordance with its terms and are to be performed at the level and in the manner specified in the contract.

Warranty of Authority. Each person signing this Amendment warrants that he or she is dually authorized to do so and to bind the respective party to the amendment

By signing this form | certify that:

« I had the opportunity to review the to the Voluntary Preki ten
(VPK) Provider Contract.

« I have examined this amendment and, to the best of my and belief, the
provided is true and correct.

+ I understand that upon the approval of my provider's 1 will receive noti my

amendment is in force.
« am duly authorized to sign and bind the respective party to the amendment.

Submit Amendment

% Full Name

* Tiie Director

* Certified by electronic signature
Amendment sign date 5952021

e ]

£ Previous Step
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The successfully completed, signed, certified, and submitted message appears.

Navigate to Contracts > Manage Contracts.

The Manage Contracts page displays. Click the plus “+” sign to the left of the VPK contract that is being amended to
expand the amendment section. The amendment is in Submitted status.

To preview the submitted DEL-VPK 20A form and any associated exhibits, click the View button.
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Viewing a Certified VPK Contract Amendment

Navigate to Contracts > Manage Contracts.

The Manage Contracts page displays. Click the plus “+” sign to the left of the VPK contract to expand the
amendment section. The amendment is in Certified status.

To preview the certified DEL-VPK 20A form and any associated exhibits, click the View button, or click the
Download button to download the amendment as a PDF.

Manage Contracts
Show | 10 | entries 2 Clear All Fiters Search:

View Termination Program
Type of Contract Contract Name Coalition Last Updated Contract Effective Date Date Year
Filter Filter Filter Filter Filter Filter Filter Filter Filter Filter Filter
\ 95013 VPK OEL-VPK 20 ELC of Alachua Certified 3/8/2022 & View 7/1/2022 2022 -2023

Show 10 ~ entries

Amendment ID 1L staws Effective Date View Decument Action
28718 Certified 07/01/2022

First  Previous - Next  Last

NOTE: The amendment status changes from Initiated to Incomplete while the amendment is being edited.
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Enrollments - VPK

VPK Providers may manage VPK enrollment online by going to Enrollments > Manage VPK Enroliments. Two
options are available: Request/Change Enrollment and Bulk File Upload.

Request/Change Enrollment

This feature allows VPK Providers to request or change enroliment for children in verified classes submitted
through the VPK Provider Application. To begin, select the VPK Program Year, VPK Session, and VPK Class.

& Reguest/Change VPK Enroliment @ Bulk VPK Enroliment

VPK Program Year: m VPK Session: m VPK Class: m Class Start Date: Class End Date:

Max Class Size: 0 VPK Children Count: 0 Non-VPK Children Count:

Please Note: Based on the VPK session and instructors assigned, the maximum class size iz 0. The class must have a minimum of 4 VPK children to start

Certificate Number : Child First Name : Child Last Name : Child DOB: MW/DD © Enroll to this Class
Certificate Number Child First Name Child Last Name | Child DOB | Child Age W Anticipated Start Date Actual Start Date | Termination Effective Date W

Please choose valid program year, session and class from drop downs to see results.

With the VPK Program Year, VPK Session, and VPK Class selected, the class start date and end date appear as well
as the max class size. This information is directly tied to the VPK Provider Application. For example, if there is one
lead instructor for the school-year session submitted and verified on the VPK Provider Application, the max class
size will be 11; if there are two instructors for the school-year session submitted and verified on the VPK Provider
Application, the max class size will be 20.

Next, the VPK children count and Non-VPK children count are displayed. These two counts (summed together)
cannot exceed the max class size. The Non-VPK children count is used to anonymously indicate private pay
children participating in the VPK class. The Non-VPK children count defaults to zero. When the Non-VPK children
count is used, the number of VPK children permitted in the class is reduced to maintain the max class size limit.
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The class roster records are also displayed. If there are no children enrolled in the class, a “No records found for
this class” message displays.

]

If there are/were children enrolled in the class, the records are listed with the current enrollment status (Enrolled,
Enrolled-Change Requested, or Enrollment Ended (Terminated)).

)

—

Enrolling a VPK Child

Using the child’s approved Certificate of Eligibility (COE) provided by the family, enter the Certificate Number, Child
First Name, Child Last Name, and Child DOB. Then, click Enroll to this Class.

NOTE: The fields are not case sensitive; however, the certificate number must be entered exactly as it appears on
the COE (i.e. VPK#####-YYYY).
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The system verifies that the information entered matches a child with an approved COE for the VPK program year
selected and that the child is not already enrolled (or in a non-eligible status for enrollment).

NOTE: The county on the COE does not have to match the provider’s county because the child has been deemed
eligible to participate in the VPK program. The enrollment process automatically updates the child’s county for
service to the provider’s county so the corresponding early learning coalition may manage the child’s enrollment
with the provider.

When a matching child is found and validations checks are successful, a confirmation message appears. To
continue, click Yes.

Next, the system asks for the Anticipated Start Date. This is the date the child will begin attending class. Typically,
this is the class start date unless the child is starting after the class begins.

NOTE: An anticipated start date cannot be before the class start date or after the class end date. And, an
anticipated start date cannot be before the child's COE issue date (as displayed on the child’s COE and listed in the
enrollment window).
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The system validates each enrollment request to make sure the max class size is not exceeded (based on the
number of instructors assigned, the VPK session type, and current class enrollment count). To continue, click
Enroll Child.

When the enrollment request is successful, the child appears on the class’s enrollment roster as “Enroliment
Submitted" and the coalition receives the enrollment request for review/approval/rejection. In addition, the
family receives a notification that their child’s enrollment is in progress.

While the enrollment request is being processed by the coalition, the status is updated on the enroliment roster.
For example, the coalition has changed the status to Coalition Reviewing.

If the coalition rejects or cancels the enrollment request, the child will no longer appear on the class roster. The
VPK Director and family will receive an email notification. The family is instructed to download their child’s COE
from the Family Portal and re-start the enrollment process.
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When the enrollment process is approved by the coalition, the child’s status is Enrolled.

Managing VPK Enrollment

The class roster has several features for managing enrollment. Providers may change the anticipated start date,
request to move the child to another class, remove the child entirely from the roster because they never attended,
or request a termination of services.

Change Anticipated Start Date

To change the child’s anticipated state date, click Change within the Anticipated State Date column. A window
displays. The current start date populates in the From field; enter the new start date in the To field. This feature
does not require coalition approval. Click Save to commit the new date or click Close to abandon the date change
and close the window. This feature is available until the actual start date is recorded through the attendance
process. When the actual start date is populated in the column, the Change button is no longer available.

Class Change

Once the child's status is Enrolled, a class change may be requested. To change the child’s class, click Class Change
within the Actions column. A window displays. The current class populates in the From field; select the new class
in the To field and enter the Transfer Effective Date. The Transfer Effective Date should be the first day the child
will attend the new class. This feature requires coalition approval. Click Submit Request to send the request to
the coalition or click Close to abandon the class change and close the window.

NOTE: Once a class change request is submitted to the coalition, a subsequent class change request for the same
child is not allowed until the initial class change request is processed by the coalition.
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Now that the class transfer request is submitted, the child appears on the roster for both classes. In the From
class, the child’s status is Enrolled.

In the To class, the child’s status is Enrolled - Change Requested.

When approved, the From class has a termination effective date (same as the transfer effective date). If the
termination effective date has not passed, the status is Enrolled. When the termination effective date occurs, the
status will be Enrollment Ended. No further actions can be taken on this enroliment.
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When approved, the To class is Enrolled with an anticipated start date and actual start date (same as the transfer
effective date).

NOTE: A class transfer request cannot be submitted for a child if the transfer effective date overlaps an existing
enrollment period for that child. If the transfer effective date is BEFORE the termination effective date of the last
enrollment, an error message appears, “The class transfer effective date overlaps an existing enroliment period for
this child."

When rejected, the request no longer appears in the To class. The child remains enrolled in the From class.

Class Change to a Full Class
If a provider wants to move a child from class BF18 to class AF18, but class AF18 is full, the class change can still be
done.

Class BF18 is not full.
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Class AF18 is full.

The provider wants to move Blue Fairy Latham to AF18 from BF18.

1® Change Child Enroliment

Certificate Number: VPHTH2-2018 Certificate Issue Date: 072802018
Child Name: Blue Fairy Latham Child Date Of Birth: 03/082013
Anticipated Start Date: 12/10/20138 Class ID:  BF13 - Forest Room

= Transfer Child Class €}

0 Cosition approval requined
Fromc | BF18 - Forest Room | To: | —Select— w
Transfer Effective Date: MDD Y =

& Submit Request
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The provider selects AF18 in the To field and enters the Transfer Effective Date. Once the Submit Request button is
clicked, the provider receives a red message.

1% Change Child Enroliment

Certificate Number: VPKTS2-2018 Certificate Issue Date: 07/28/2018
Child Name: Blue Fairy Latham Child Date OFf Birth: 03/0&/2013
Anticipated 5tart Date: 127102018 Class ID:  BF12 - Forest Room

= Transfer Child Class €}

0 Coaltion spproval reguired
Fromc EF18 - Forest Room | Ta: | AF12 - Flower Room W
Transfer Effective Date: D2/2Tr2ME i

[ Swap spot with enrolled child from selected class.

Tarnget class is full. Please choose a valid class or select the swap child feature.

& Submit Request m
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Now, the provider can either select a class that is not full, or select a child to swap with in the full class. Click the
Submit Request button to complete the class change.
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Never Attended

To remove a child from a class completely because they never attended, click Never Attended within the Actions
column. A window displays. This feature does not require coalition approval. Click Yes to remove the child or click
No to abandon the removal and close the window. Removing an enrollment changes the record’s status to
Enroliment Cancelled and the enrollment process starts over for the family. The provider’s VPK Director will
receive an email notification to inform them the enrollment is removed; no attendance or reimbursement may be
sought. The child’s record is no longer listed on the class enrollment roster or attendance roster in the Provider
Portal. The family will receive an email notification to inform them the enroliment for their child was cancelled;
instructions are provided to log into the Family Portal to download the child’s COE and select another VPK
provider.

This feature is available until the actual start date is recorded through the attendance process. When the actual
start date is populated in the column, the Never Attended button is no longer available.

NOTE: Be very careful with the Never Attended feature. If the intention is to transfer the child to a different
classroom, use the Class Change feature. If the child attended class, VPK instructional hours were used, and
reimbursement is needed, use the Terminate feature.
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Terminate
To terminate a child’s enrollment, click Terminate within the Termination Effective Date column. A window

displays. Enter the last day that services will be/were rendered and select the reason for termination. The
Termination Effective Date is displayed below the Last Day of Services as one day after the last day of services.
Therefore, the Termination Effective Date is the first day the child is NOT attending class. This feature requires
coalition approval. Click Submit Request to send the request to the coalition or click Close to abandon the
termination request and close the window.

NOTE: A child’s enrollment cannot be terminated before the class start date. If the provider enters a date in the
Last Day of Services that is BEFORE the class start date, an error message appears, “Termination effective date
cannot be prior to the class start date. If the child never attended, click the Never Attended button to cancel the
enrollment.” Either enter a termination date that is after the class start date (and on or after the COE issue date),
or click Close to abandon the termination request and close the window.

When the termination request is submitted, the child appears on the class’s enrollment roster as “Enrolled -
Change Requested.” The coalition will receive the termination request for review/approval/rejection.

When the termination request is approved and the termination effective date has not passed, the status is
Enrolled. When the termination effective date occurs, the status will be Enrollment Ended. No further actions can
be taken on this enroliment.
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When rejected, the child remains enrolled in the class.

VPK Bulk Enrollment Process
In addition to the enrollment method described in “Enrolling a VPK Child,” providers may submit enrollment

requests to the coalition via a file process. To begin, click the Bulk VPK Enrollment tab. The bulk file processing
page displays.

Next, click on the link to download the CSV file template. The file may appear at the bottom of the computer
screen depending on the user’s browser.

)

Open the file and expand the columns. Each column is explained below.
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VpkEnrollmentBulkUpload (28).csv - Excel

Insert Page Layout Formulas Review View LOAD TEST Q Tell me what you want to do...

s - =
% Cut Calibri -1 - KN S== #- EWapTet General - =¢ 4 | Normal Bad Gon
ER Copy - )
Paste o | o - l===== > o <o oo Conditional Formatas 8715w Explanatory ... |Im
*  Format Painter B I U fass - A == = | =3 Merge & Center $-% » W% Formatting~  Table « ! Y P
Clipboard [F] Font [F] Alignment ] MNumber [F] Styles
B9 < 5
A B c | D | E F | 6 H 1 |

| | |
1 |Provider ID Certification Number Child First Name Child Last Name Child DOB(MM/DD/YYYY) VPK Program Year ClassID Anticipated Start Date(MM/DD/YYYY) MSID{XX-XXXX)

2
3
4

A. Provider ID = this is the provider ID for the site displayed on the Provider Portal home page/dashboard.

Provider Sile Summary Frequently-Used Links

Business name: Growing Up Strong, LLC Bright Beginnings
Doing business as: Growing Up Sirong Core Competencies
| Provider ID: 19449 DCF Provider Training

License number: Early Learning Performance Funding Project

SSN / Federal ID number: _ Provider Portal User Guide

VPK Provider Readiness Rate Website

B. Certification Number = this is the child’s certificate number listed on their COE. The field is not case
sensitive, however, the certificate number must be entered exactly as it appears on the COE (i.e.
VPK##H#H#-YYYY).

C. Child First Name = this is the child’s first name listed on their COE. The field is not case sensitive.

D. Child Last Name = this is the child’s last name listed on their COE. Do not include a suffix (if any). The field
is not case sensitive.

E. Child DOB (MM/DD/YYYY) = this is the child’s date of birth listed on their COE. The field will accept
M/D/YYYY as well.

F. VPK Program Year = this is the child’s approved VPK program year listed on their COE. The field is looking
for the first 4-digit year only. For example, if the VPK program year is 2017-2018, the entry would be
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2017. Generally, the 4-digit VPK program year matches the year included at the end of the child’s COE
number.

Class ID = this is the desired class’s 4-digit ID. The class ID must be entered as the 4-digit assigned ID. Do
not include the class name (if any). Looking at the example below, the entry would be “AS17” not
“Songbirds” or “AS17-Songbirds.”

@ Reguest/Change VPK Enroliment @ Bulk VPK Enroliment

VPK Program Year:  2017-2018 v  VPK Session: | Summer (300 hours) v | VPKClass:  AS17-Songbirds v | Class Start Date: 06/04/2018  Class End Date: 07/26/2018

Anticipated Start Date (MM/DD/YYYY) = this is the date the child will begin attending class. Typically,
this is the class start date unless the child is starting after the class begins.

NOTE: An anticipated start date cannot be before the class start date or after the class end date. And, an
anticipated start date cannot be before the child's COE issue date. The field will accept M/D/YYYY as well.

MSID (XX-XXXX) = this field is for public schools only. Public schools may enter their Master School
Identification (MSID) number in a 6-digit format, where the first 2 digits are the district number followed
by a hyphen and 4-digit school number. The MSID number can be used in lieu of the Provider ID in
column A. Both IDs are accepted.

When the file is complete, name it and save it as a CSV file type.

NOTE: It may be helpful to include the provider name and class in the file name if troubleshooting is ever

necessary.
Save As X
« < 4 B s ThisPC » Desktop w & Search Desktop el
Organize = MNew folder == - o
[ This PC ~ MName Date modified Type Size
[ Desktop Questions Log File folder
[£ Documents VPK Enrollment Attendance File folder
Bulk Enrollment Files File folder
4 Downloads
i Security File folder
D Music
Reimbursement File folder
=] Pictures Sprints File folder
B videos system pics File folder
i Local Disk (C:) Pay Rates File folder
s BLANK (E2) Meeting Notes File folder
== andrea.latham (\\oel-ded\users) (| VPKSIS ! " File folder
MRICSRAanuals g T AR File folder
unitdata (VUEL-dcd) (5]
Contracts 129/, NPM _ File folder v
Bl ARIK (B . *
File name: | A517 Songbirds Upload o~
Save as type: | CSV (Comma delimited) (*.csv) ~
Authors:  Andrea Latham Tags: Add atag Title: Add a title
~ Hide Folders Tools  ~ cel
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When changing the file format to CSV, Excel often displays a message to ask if you want to keep using that format.
If this message appears, click Yes.

Insert Page Layout Formulas Data Review View LOAD TEST Q Tell me what you want ts
o - = :

& cut Calibri -1 AN S== ®- EeWapTet General - " # | Normal Bad Good Ne

Bl Copy - o
Paste P I == - - <o 0o Conditional Format as IZ' Explanatory ... n

"% Format Painter I u F €= 3= & Merge & Center $-9% » | WD Fomatting - Table- ! ¥ E L

Clipboard L] Font ] Alignment LM Mumber ] Styles

B7 = I
A B Cc D E F G H | J
1 |Provider ID Certification Number Child First Name Child Last Name Child DOB(MM/DD/YYYY) VPK Program Year ClassID Anticipated Start Date{MM/DD/YYYY) MSID{XX-XXXX)
2 | 19449 VPK1095621-2017 KitKat Latham 2017 A517 7/2/2018
3 | 19449 VPK1095625-2017 Hersey Latham 9/9/2012 2017 AS17 7/2/2018
4 | 19449 VPK1095626-2017 Baby Ruth Latham 9/9/2012 2017 As17 7/2/2018
5 | 19449 VPK1095627-2017 Butterfinger Latham 9/9/2012 2017 A517 7/2/2018
6
7
"

8 -
el -
10|
11
12
13
14|
15| Microsoft Excel x
o] o Some features in your workbook might be lost if you save it as CSV (Comma delimited).
17
18- Do you want to keep using that format?
19| Yes No Help
20|

Click the Upload button. A window displays. Select your file and click Open.

]

The file upload will begin. The file details will populate on a row and turn green. Click the Refresh button to
populate the results.

)

The file details will be updated. The file size, total records count, committed records count, failed records count,
processed time, status, and final results are updated. The file results are also returned and can be downloaded by
clicking on the Download button.
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In this example, there is one failed record and three committed records. The file download will include the error
message and status for each record submitted. The three committed records are now “Enrollment Submitted” and
the failed record was not included because of an invalid date of birth. The same validations that occur with a
manual child enroliment occur with the bulk enroliment file process.

Insert  Pagelayout  Formulas  Data  Review  View  LOADTEST @ Tell me what you want

o
% Cut Calibri 5 Wrap Text General - - # | Normal Bad Good Neutral
Past; B Copy - G d | Fo pt
aste . . . +o on  Conditional Format as lZl Explanatory ... Linked Ce
"t % rormatpainter | B 1 U Merge & Center $-9% » %N e : Y P _Linked Ce
Clipboard ] Font ] Alignment & Number & Styles
D17 = I
A B C D E F G H |
1 |Provider ID Certification Number Child First Name Child Last Name Child DOB({MM/DD/YYYY) VPK Program Year ClassID Anticipated Start Date(MM/DD/YYYY) MSID(XX-XXXX| Error or Status
2 19449 VPK1095621-2017 KitKat Latham 2017 AS17 7/2/2018 Invalid Date of Birth
3 19449 VPK1095625-2017 Hersey Latham 9/9/2012 2017 AS17 7/2/2018 Enrollment Submitted
4 19443 VPK1095626-2017 Baby Ruth Latham 9/9/2012 2017 As17 7/2/2018 Enrollment Submitted
g 19449 VPK1095627-2017 Butterfinger Latham 9/9/2012 2017 As17 7/2/2018 Enrollment Submitted

The three committed records are displayed on the class’s enrollment roster as “Enrollment Submitted" and the
coalition receives the enrollment requests for review/approval/rejection. In addition, the family receives a
notification that their child’s enrollment is in progress. The same processes that occur with a manual child
enrollment occur with the bulk enrollment file process.

NOTE: When correcting records and re-uploading the file, be sure to remove the “Error or Status” column as it is
not accepted for the upload. Also, it is best to NOT include records that have already been submitted successfully
as they will now error as having been processed. When removing successful records and the Error or Status
column, it is best to highlight the row/column and use the cut/delete option instead of just deleting the
information. Excel often retains formats even if the cells are now empty.

)
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VPK-20 Contract Verification

A provider must have a Certified VPK-20 contract on the Anticipated Start Date before an enrollment can be
added. In the below example, the VPK application information is entered by the provider, and the + Enroll to this
Class button is clicked.

]

In this example, the provider does not have a Certified VPK-20 contract, so an error message displays, alerting the
provider that the enrollment cannot be submitted.

I® Request Enrollment

Enrcliment cannot be submitted without a certified VPK-20 contract. Please contact your early
learning coalition for assistance.
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Enrollments - SR

Pending Family Acceptance Status

When a new School Readiness enrollment is created for an eligible child, families must accept the terms and
conditions, establish their consent for developmental screening and/or child assessment, and sign the payment
certificate. Families receive an email notification from DEL every five days until these steps are completed and the
enrollment status changes from Pending Family Acceptance to Enrolled.

New enrollments in Pending Family Acceptance will not be visible on provider attendance rosters and will only
appear once the family signs the payment certificate; however, there are exceptions.
e New enrollments for at-risk children (BG1) or at-risk children in relative care (BG3R) billing groups in
Pending Family Acceptance will populate on attendance rosters
e Existing enrollments in Pending Family Acceptance that have already been submitted for attendance in
previous months will continue to populate on attendance rosters

Providers will be able to process attendance and be paid for these enroliments, but not until the payment
certificate is signed by the family.

If a provider has new enrollments in Pending Family Acceptance, when the provider accesses SR attendance, a
pop-up window will display with a count of those new enrollments and a link to the Manage SR Enroliment queue.
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Viewing Enrollments in Pending Family Acceptance
To view enrollments in Pending Family Acceptance, navigate to Enroliments > Manage SR Enroliments >
View/Edit SR Enrollments > Pending Family Acceptance.

Ending Enrollments in Pending Family Acceptance

Providers can end enrollments in Pending Family Acceptance. Navigate to Enrollments > Manage SR Enroliments
> View/Edit SR Enrollments > Pending Family Acceptance. Find the enroliment, then click the End Enrollment
button.

£ Clear All Filters Search:

Attendance Enroliment
Start Date End Date

Filter Filter Pendir

Pending | |
Family
Acceptance

A confirmation pop-up window displays. Click Yes to continue or No to stop the End Enrollment process.

End child SR enrollment

Do you want to end this Provider Enrollment?
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After clicking the Yes button, the following pop-up window displays. Complete the required information and click
Save.

End SR Enrollment

YYou have chosen to end enroliment for this child.

End Enroliment Reason®

-- Select a Termination Reason — ~

Last Attendance Date™

MM/IDDYYYY B

Is there a past due parent fee?*

OYes O No

Cance'

After clicking Save, a confirmation pop-up window displays. Click Yes to end the enrollment or Cancel to cancel the
End Enrollment process.

After clicking the Yes button, a pop-up window displays a message that the enrollment is ended. Click Ok to
continue.

©®  End Enroliment

Child enrcllment was successfully ended
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Cancelling Enrollments in Pending Family Acceptance

Providers can cancel enrollments in Pending Family Acceptance, but only if the enrollment is not for an at-risk
child (BG1) or at-risk child in relative care (BG3R) and attendance has not been submitted for the enroliment.

Navigate to Enrollments > Manage SR Enrollments > View/Edit SR Enrollments > Pending Family Acceptance.
Find the enrollment, then click the Cancel Enrollment button.

A confirmation pop-up window displays. Click Yes to cancel the enrollment and remove it from the SR Enroliment
queue. Click No to stop the Cancel Enrollment process.
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SR Eligibility Redeterminations

The SR Eligibility Redetermination menu allows providers to view enrollments with “upcoming” or “past due”
redeterminations. These queues are for informational purposes only and aid providers in knowing when an
enrolled child is reaching the end of their School Readiness eligibility.

Upcoming Eligibility Redeterminations
To see the enrollments with upcoming eligibility redeterminations, navigate to Enrollments > Manage SR
Enrollments > Redeterminations > Upcoming Redeterminations.

Redetermination records will only appear in the Provider Portal Upcoming Redetermination queue when:
e  Child eligibility status is Eligible
e Child enrollment status is Enrolled or Pending Family Acceptance
e The redetermination is within 45 days from the due date

Past Due Eligibility Redeterminations

To see the enrollments with past due eligibility redeterminations, navigate to Enrollments > Manage SR
Enrollments > Redeterminations > Past Due Redeterminations.

Redetermination records will only appear in the Provider Portal Past Due Redetermination queue when:
e  Child eligibility status is Eligible
e  Child enrollment status is Enrolled or Pending Family Acceptance
e Theredetermination is at least one day past the redetermination due date

After clicking the Upcoming Redeterminations or Past Due Redeterminations link, the following appears.
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Click the link for a child name in the Child Name column, and a pop-up message displays child eligibility and
enrollment details for the child.

Click View in the Payment Certificate column, and a pop-up message displays the payment certificate for the
enrollment. If the payment certificate does not exist, the View button will not be active, but hovering over the
button displays a message: "The payment certificate is not viewable until signed by the parent."

NOTE: If the ELC changes the Household Eligibility Status from Redetermination to Active or Inactive, the child’s
eligibility will be removed from Redetermination status and the record(s) will be removed from the Provider Portal
Redetermination queues.
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Temporary Closures

Temporary closures must be created when the whole site or program or specific classroom is
temporarily closed due to emergency circumstances. Provider and Coalition users can initiate temporary
closures.

NOTE: Temporary closures must be created BEFORE attendance is submitted for the month in which the
closure occurs.

To add a closure, navigate to Attendance > Temporary Closures

or use the Click here! link on the SR or VPK Attendance Roster.
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Click the Add Temporary Closure button.

The Report Temporary Closure pop-up window opens.
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Creating a Temporary Closure for a Whole Site Closure

Complete the form. Hover over the information icons € for additional information.

e Closed Provider Site(s) — Select the site(s) that were temporarily closed due to emergency
circumstances. Each site that the user has access to is listed. Only providers with VPK or SR
enrollments display in the dropdown list.

NOTE: If providers were closed for different dates, they should be unchecked and have separate
closure events created.

e Closure Details — Enter the closure date range. The “Closed From” date is the first day of the
closure and the “Closed To” date is the last day of the closure. A single day closure would have
the same “Closed From” and “Closed To” date. No services are available on dates included in the
closure date range.

NOTE: The closure date range is limited to a single month. If the closure crosses into the next
month, an additional closure is needed to cover that time period.

Clicking the No Services checkbox will select multiple providers with whole site closures and a pop-up will indicate
that all classes and care levels are selected for all providers
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Unchecking the No Services checkbox will deselect all providers, but all classes and care levels for each provider

are still selected. The user will need to deselect classes and care levels for each provider that should not be
included in the closure.

e Closure Reasons — Select the applicable reason(s) for closure. If ‘Other’ is selected as the
closure reason, then a comment is required.

e Documentation — Click the Upload Document button to upload necessary documents (optional).
e Comments — Enter comments related to the closure. If no comments are entered when the form
is saved or submitted, the system will enter “Closure added by provider user” in the comments.

Clicking the Save button on the Report Temporary Closure form saves the record in “Incomplete” status.
Incomplete closure forms can be seen by the coalition for assistance. To edit a temporary closure
record, click the Edit button on the incomplete record.

Edit the closure details and click Submit to Coalition. After clicking the Submit to Coalition button, the

Sign and Certify message appears. Complete the authorized electronic signature fields, then click
Submit.
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The temporary closure is submitted to the coalition. The record appears in the Submitted closures
gueue in “Submitted” status.

Creating a Temporary Closure for all or some SR Care Levels.
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Complete the form. Hover over the information icons © for additional information.

e Closed Provider Site(s) — Select the site(s) that were completely, temporarily closed due to
emergency circumstances. Each site that the user has access to is listed. Only providers with a
certified contract display in the dropdown list.

NOTE: If providers were closed for different dates, they should be unchecked and have separate
closure events created.

e Closure Details — Enter the closure date range. The “Closed From” date is the first day of the
closure and the “Closed To” date is the last day of the closure. A single day closure would have
the same “Closed From” and “Closed To” date. No services are available on dates included in the
closure date range.

NOTE: The closure date range is limited to a single month. If the closure crosses into the next
month, additional closure is needed to cover that time period.

e Reimbursement Requests — Select the care level(s) impacted by the closure. Check the
checkbox for the care levels to include it in the closure.

NOTE: The days default to ‘CR’.

PR5 August 2022
VPK Classes (00f0) SR Care Levels (507 7) sun Mon Tue Wed Thu Fri Sat
1 2 3 4 5 6
| _CR |
INF - < 12 Months
7 8 9 10 11 12 13

TOD - 12 < 24 Months
2YR - 24 < 36 Months
[ PR3 - 36 < 48 Months 14 15 16 7 18 19 20
PR4 - 48 = 60 Months

W PRS-60 <72 Months 21 22 23 24 25 25 27

SCH - In School

28 29 30 3

Total Processed Closure Reimbursable (CR) Days in Program Year: 0 €

3 - Closure Reimbursable. [[E1]] = Closure Non-Reimbursable

e Clicking on CR changes the value to CN and vice versa.

e Closure Reasons — Select the applicable reason(s) for closure. If ‘Other’ is selected as the
closure reason, then a comment is required.

e Documentation — Click the Upload Document button to upload necessary documents (optional).

e Comments — Enter comments related to the closure.

e Clicking the Submit button submits the closure to the coalition. The record appears in the
Closures grid with “Submitted” status. Itis available in Coalition’s ‘Submitted’ queue.
NOTE: Save button saves the record in ‘Incomplete’ status.

e Complete the authorized electronic signature fields, then check the Certify by Electronic
signature box, then click the Submit button.
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e Clicking the Submit button submits the closure to the coalition. The record appears in the grid
with “Submitted” status. It is available in Coalition’s ‘Submitted’ queue.

Once the submitted record is processed by the coalition, the record changes to Processed status.

NOTE:

1. When the status of the record is submitted, there is only a View button. The provider cannot
edit or delete a temporary closure record that is in Submitted or Coalition Reviewing status.
2. Incomplete and Processed records can be deleted.

3. If a coalition adds more providers to the closure that the provider user does not have access to,
there will not be a Remove button.
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Individual students, not affected by a temporary closure, may be edited in SR attendance. For
example, a 2 Year Old class has 6 children showing a CR for the temporary closure, but 3 of them
were present on the CR days. The provider can change the CR days to an X to mark the 3

children present.
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Creating a Temporary Closure for all or some VPK Classes.

Complete the form. Hover over the information icons € for additional information.

Closed Provider Site(s) — Select the site where some or all VPK classes were temporarily closed
due to emergency circumstances. Each site that the user has access to is listed. Only providers
with enrollments display in the dropdown list.

Closure Details — Enter the closure date range. The “Closed From” date is the first day of the
closure and the “Closed To” date is the last day of the closure. A single day closure would have
the same “Closed From” and “Closed To” date. No services are available on dates included in the
closure date range.

NOTE: The closure date range is limited to a single month. If the closure crosses into the next
month, an additional closure is needed to cover that time period.
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e C(Classes and Reimbursement Requests — Select the class(es) impacted by the closure using the
checkbox.
0 The Missed Instructional Hours pop-up window opens.
= Selecting ‘Yes’, marks the day as ‘Closure Non-Reimbursable’ (CN) in the
calendar.
= Selecting ‘No’, marks the days as ‘Closure Reimbursable’ (CR) in the calendar.

= The days populate as CN — Closure Non-Reimbursable or as CR — Closure
Reimbursable.
= Clicking on CN changes the value to CR and vice versa.
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Closure Reasons — Select the applicable reason(s) for closure. If “Other” is selected as the
closure reason, then a comment is required.

Documentation — Click the Upload Document button to upload necessary documents (optional).
Comments — Enter comments related to the closure. If no comments are entered when the form
is saved or submitted, the system will enter “Closure added by provider user” in the comments.
After clicking the Submit to Coalition button, the Sign and Certify message appears.

NOTE: Clicking the Save button saves the record in “Incomplete” status. The coalition can view
incomplete forms.
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e Complete the authorized electronic signature information, then click the Submit button.

e Clicking the Submit button submits the closure to the coalition. The record appears in the grid
with “Submitted” status. Itis available in Coalition’s ‘Submitted’ queue.
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VPK Non-Reimbursable Temporary Closures
After the coalition approves a temporary closure that has non-reimbursable (CN) days, VPK providers

must take additional steps to complete the process. When the temporary closure with non-reimbursable
days is set to “Processed”:

1. The provider’s VPK provider application (VPK-APP) is changed to “Incomplete” status.

2. If the class(es) associated with the non-reimbursable closure shares a calendar with another class,
the system separates the calendar so that each class that shared the calendar will have its own
calendar. In other words, the original class calendar is cloned as many times as needed and each
cloned calendar is assigned to a class so that all classes involved in the closure have its own
calendar. (One of the classes will keep the original calendar.)

e A new cloned calendar’s name consists of the word “Revised:” followed by the original
calendar’s name and the associated class’s name in parenthesis.

e Ifthe original calendar does not have a name, the cloned calendar’s name will only consist of
“Revised:” and the associated class’s name in parenthesis.

Example:

Original Calendar:

Cloned Calendar assigned to class AF21:

3. The non-reimbursable temporary closures for each class are automatically written to the original
and/or cloned calendar as “Non-Instructional: Temporary Closure Added” in the correct service
period month.

NOTE: When non-instructional temporary closure days are added to a VPK calendar, the Total Calculated
Hours are reduced, so the provider must adjust the calendar to restore the calculated hours to “540”.

4. An email notification is sent to the provider advising that their VPK-APP is in non-certified status due

to a temporary closure. The provider is instructed to log into the account to update and submit the
VPK-APP to the coalition.
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Update VPK Class Calendar

Providers must revise their VPK class calendar(s) in their VPK-APP to make up the hours for the non-
instructional day(s) due to temporary closure (CN days). In the Provider Portal, navigate to the Contracts
> Manage Contracts. Or, on the home page Common Tasks section, click the VPK Provider Application
link.

On the Manage Contracts page, click the Edit button for the incomplete VPK-APP.

Manage Contracts

Show 10 ~  entries = CIearAII Filters Search;

S e e e g Ol
D 1¥ | Type of Contract Last Updated Contract Effective Date Date Year

Filter ‘ VPK-APF| Filter Filter Filter Filter Filter Filter Filter Filter Filter

29683 VPK-APP VPK 10,11A.118 Incomplete 8/29/2021 GEat 2021-2022
24341 VPK-APP VPK 10,11A 1B Certified 6/30/2021 81012020 2020 - 2021
16030 VPK-APP VPK 10,114,118 Certified 6/24/2020 GEdit 81212019 2019 - 2020
7313 VPK-APP VPK 10,11A,118 Certifiea 71112019 8/13/2018 2018 - 2019
710 VPK-APP VPK 10,11A,11B Certified 701112019 GEat 512912018 2017 - 2018

Showing 1 to 5 of 5 entries (filtered from 17 total entries) First Previous - Next Last

Click the VPK Calendars tab to open the calendars page.
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Identify the calendar(s) with the non-instructional temporary closure days. Click the Edit button to make
changes to a calendar. The system defaults to the first calendar month of the class. Click the forward
arrow if needed to view the month with the closure.

The Totaled Calculated Hours will be reduced for each non-instructional day based on the hours defined
for the day.

Make adjustments to the calendar to restore the hours to 540. This can be accomplished in a variety of
ways such as:
e Canceling previously identified future non-instructional days

e Extending the class end date
[ ]

Extending the time on instructional days by creating Instructional Day Exceptions with different
class hours
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When the changes are done and the calculated hours are restored, click the Save button.

NOTE: These steps must be completed for each impacted calendar.

When all impacted calendars are updated, click on the Certify and Submit tab. Complete the signature
information, then click the Submit VPK Provider Application button.

Attendance Policy Qg VPK Director yi VPK Instructors & VPK Calendars (i} VPK Class(es) it Review = Certify and Submit #f

# Certify and Submit

By signing this form | certify that:

« To the best of my ge and belief, the i ion provi is true and correct.

« If any information changes, | (PROVIDER) will notify the COALITION within 14 days of the change.

| that if changes il prior to receipt of COALITION approval may result in pli with VPK req

+ Each VPK instructor listed has submitted an attestation of good moral has pi ion to be in the files of the PROVIDER/DISTRICT and the COALITION documenting
that the indivi has alevel2 g ing within the previous five (5) years in accordance with section 435.04, F.S., which that the indivi is not to actas

a VPK instructor; and is not ineligible to teach in a public school because the instructor’s educator certificate has been suspended or revoked.
« Each credentialed VPK instructor listed has the credentials required for the VPK program.
« lunderstand that my information will be shared with the Department of Children and Families, Office of Child Care Regulation, for inclusion in the CARES system.

Provider Signature

Signer's Name#

Day Time Phone Number#

55655555555

Electronic Signature ¥

Check this box to certify by electronic signature

Application Gompletion Date ¥
08/29/2021

Submit VPK Provider Application

After clicking Submit VPK Provider Application, the VPK-APP status changes to “Submitted” and the
application is available for the coalition to review.

NOTE: Since reimbursable temporary closure (CR) days do not reduce the total class hours, they will not
be added to the VPK calendar.

182



Attendance Rosters

After the temporary closure is processed by the coalition, the temporary closure days will show on SR
and/or VPK attendance rosters as CR or CN.

NOTE: For VPK, if there were any CN days, the coalition must review the provider’s updates to the VPK
calendar and set the VPK-APP status to Certified before attendance can be done.

In the blue header, the temporary closure details display the closure dates.

SR Attendance Roster:

A “@” symbol indicates that the child’s care level is impacted by a temporary closure during the service
period.
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VPK Attendance Roster:

' PreKindergarten (VPK
g ( ) © Class attendance has NOT been submitted to Coalition at this time.

Due Date : 9/3/2021 Class AF21-3hr AM Max Class Size20
Start Date 8/10/2021 End Date 5/27/2022
Curriculum Mother Goose Time Edition 2017

Temporary Closure (ID: 25242) 08/13/2021 - 08/20/2021

= Indicate the child's attendance below. Supporting documentation may be uploaded to the Document Management Library as needed.

August 2021

Child's Current Information

sun Mon Tue Wed Thu Fri sat Name
1 2 3 4 5 5 7 DOB Age 4
= = = s = (= [ = Status Enrolled BGrp VPK
Cert VPK -2021
k) 9 10 1 12 13 14 o RS
ass -afr
= || = |[Tx X er =
Monthly Attendance Summary
15 16 17 18 19 20 21 Days Present 8
[ % [ cR [ cR |[ e |[ cR |[ o~ |[ %= | Days absent 0
Reject Reason
22 23 24 25 26 27 28
N/A
o= X [ X | x X [ X || *®
Reject Comment
29 30 3 Rl
=

After each child’s attendance for the month is reviewed, it can be submitted to the coalition.
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Attendance - VPK

Providers manage VPK attendance online by navigating to the Attendance menu item and selecting Manage VPK
Attendance. Providers may submit their attendance through the web page or using a bulk file upload, similar to
the bulk enrollment file upload. It is important to note that changes to enrollment, such as entering a termination
date, or changes to the class schedule, such as reporting a site closure, cannot be performed in attendance.
Enrollment information must be corrected in the Enrollments area. Class schedule information must be corrected
in the Contracts > VPK Provider Application area. Any changes to source data should be done prior to submitting
attendance. Coalitions may assist as needed.

Submitting Attendance Online

Select the Manage VPK Attendance menu item. The VPK Attendance Roster displays, defaulting to the current
service period and first class. The blue summary box to the right contains class details such as the class full name,
start and end dates, and max class size. If necessary, use the dropdowns to select a different service period and/or
class.

NOTE: A service period is the month in which services were rendered. Child absences for the service period must
be marked, saved, and submitted to the coalition for payment. A due date is displayed for each service period.
Providers with multiple classes must submit an attendance roster for each class for payment.
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The search feature may be used to search for any criteria included in the roster (i.e. a name, DOB, age, billing
group, or status). The summary feature shows the current/saved attendance information for all children in one
view.

To record attendance, click on a child’s name to view their attendance for the month.

“ux

e Days the site is closed are marked with an asterisk
e Days the child is scheduled to attend are marked with an “X” for present.
e Alegend is provided in the bottom right for more code descriptions.

To change a present day to absent, click on the “X.” The “X” for present will now appear as an “A” for absent.
Absences entered by mistake can be changed back to present by clicking on the “A.”

NOTE: With Release 6.0, the Person ID is now included in the “Child’s Current Information”:

Child's Current Information

Name
Person ID 5624488
DOB 712112017 Age 5

Status Enroliment Ended BGrp VPK
(Terminated)

Cert VPK2086329-2021

Class AF21-MSHS Pink Room
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While not required, it is recommended to click Save (below the calendar) before moving on to another child.
When all child absences are marked for the month, click Save and then click the Submit to Coalition button. A
window may appear if the attendance is being submitted early or late, or if no absences have been recorded. To
continue to the Sign & Certify page, click Continue.

The Sign and Certify page displays the class summary with the total number of days absent and days present. At
this point, providers may want to print this page using the browser print function. When ready, review the
certification statements and complete the Authorized Electronic Signature portion by entering the user's Full

Name, checking the box for Certify by electronic signature, and clicking Submit. To abandon the submission, click
Cancel.
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Submitted Attendance

Upon submission, the screen returns to the VPK Attendance Roster view with the current service period displayed.
Select the submitted service period from the drop down. The submitted roster now has a submitted message and
each child shows “SUB” for submitted in the status column. This status will change as the child attendance is
processed by the coalition.

Rejected Attendance

Coalition staff may reject submitted attendance. In this case, the individual that submitted the roster will receive
an email notification. Instructions are provided to log in to the Provider Services Portal, review the roster, make
necessary changes to rejected records, and re-submit. The rejected child records are displayed at the top of the
roster list in red and show "REJ" for rejected in the status column. Only records with "REJ" may be edited.

To edit, click the name of a rejected record. Any absences previously recorded appear. Make changes as needed.
After the last record is corrected, click Save. Then, click the Submit to Coalition button and continue to the Sign &
Certify page. This time, the Sign & Certify page only shows the rejected records that are being re-submitted to the
coalition. Complete the Authorized Electronic Signature portion and click Submit.
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Upon submission, the rejected "REJ" records appear on the roster as submitted "SUB."

Approved Attendance
Coalition staff will continue to work submitted attendance until the records are approved for payment. Approved
records appear on the attendance roster as "APP" for approved in the status column.

When records are paid by the coalition, the reimbursement details are posted on the Provider Portal under
Attendance > Reimbursement Details.
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Providers can run a Payment Period or Service Period Reimbursement Report.

Final Reimbursement Report

Report Name Action

Payment Period Report

Service Period Report S

Uploading Bulk Attendance File
Providers may submit their attendance via a bulk file upload (similar to the enroliment bulk file upload process).
To begin, go to the Attendance menu item, choose Manage VPK Attendance, and then select Bulk File Upload.

The Bulk VPK Attendance page displays.

Click the CSV file template link. A window appears. From this window, select the service month and year to
generate a file for all of the enrollments (for all classes) at the site that month. Alternatively, multi-site providers
may check the "Include all providers for provider principal” box to generate a file for all of the enrollments (for all
classes) at all sites associated to the account for that month. Then, click the Download button.
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Open the downloaded file. The enroliment information for each class is pre-populated. Each instructional day
during the student's enrollment defaults to present (X).

A B T D E F G H | J K L M N o P Q R S
1 |ProviderlD MSID ProviderName COENumber FLEID ChildLastName ChildFirstName ChildDateOfBirth AttendanceMonth AttendanceYear Day 1 Day 2 Day_3 Day 4 Day_5 Day 6 Day 7 Day_8 Day 9
2 8433 Daisy Mae Daycare VPK748-2018 Latham Ariel 2/2/2014 0:00 8 2018 * * * * * * * * *
3 8433 Daisy Mae Daycare VPK751-2018 Latham Bambi 1/1/2014 0:00 8 2018 * * * * = = * - *
4 8433 Daisy Mae Daycare VPK752-2018 Latham Blue Fairy 8/8/2013 0:00 3 2018 * = * = = = = = =
5 8433 Daisy Mae Daycare VPK753-2018 Latham Pinocchio 12/12/2013 0:00 8 2018 * * * * * * * * *
6 8433 Daisy Mae Daycare VPK747-2018 Latham Aladin 1/1/2014 0:00 8 2018 * * * * * * * * *
7 8433 Daisy Mae Daycare VPK757-2018 Latham Chip 2/2/2013 0:00 8 2018 * = = = = = = b =
8 8433 Daisy Mae Daycare VPK754-2018 Latham Cinderella 7/7/2013 0:00 8 2018 * = = * = = = = *
2 8433 Daisy Mae Daycare VPK756-2018 Latham Cruella devil 2/2/2013 0:00 8 2018 * * * * * * * * *
10 8433 Daisy Mae Daycare VPK758-2018 Latham Dale 1/1/2014 0:00 8 2018 * * * * * * * * *
1" 8433 Daisy Mae Daycare VPK743-2018 Latham Hercules 1/1/2014 0:00 8 2018 * = = = = = = b =

a. Legend: present (X), site closed (*), student not started (_), student terminated (T).

b. Day_1 = first of attendance month, Day_2 = second day of attendance month, Day_3 = third day
of attendance month, etc. In this example, Day_1 = August 1, Day_2 = August 2, and Day_3 =
August 3.

c. Regardless of the month/year, columns for Day_1 to Day_31 are included in the file and are
necessary for the upload; none should be removed.

d. Itis critical that only the content of "Day_#" columns are changed (i.e. changing an X to an A).
Attempting to add students or edit/remove system generated columns will cause errors. The file
is a reflection of the enrollment information for the class when downloaded. If issues are
identified, please contact the local early learning coalition for assistance.

Scroll over to the days and record absences by changing a present day (X) to absent (A). Tip: (In Excel) Open the
View menu, select column H, and click Freeze Panes. This will keep the student's name and demographic
information in view while scrolling through days.

F H | J K L M N (o] P Q R 5 T u v w X Y z AR AB AC
1 |childFirstName  AttendanceMonth AttendanceYear Day 1 Day_2 Day 3 Day_4 Day 5 Day_6 Day_7 Day_8 Day_9 Day_10 Day_11 Day 12 Day 13 Day 14 Day_15 Day_16 Day_17 Day 18 Day_19 Day 20
2 |Crunch ] 2018 _ _ _ * * _ _ _ _ _ * * X X X X X * * X
3 |Goodbar 8 2018 _ _ - - _ _ _ _ _ - - X X X X X - - X
4 |Krackel 3 2018 _ _ = = _ _ _ _ _ = = X X X X X = = X
5 [Mentos 8 2018 _ _ * * _ _ _ _ _ * * X X X X X * * X
6 |Milky Way 8 2018 _ _ * * _ _ _ _ _ * * X X X X X * * X
7 |Payday ] 2018 _ _ = = _ _ _ _ _ = = X X X X X = = X
8 |Reese's Pieces 8 2018 _ _ * * _ _ _ _ _ * * X X X X X * = X
9 [Snickers ] 2018 _ _ * * _ _ _ _ _ * * X X X X X * * X
10 |Three Musketeers 8 2018 _ _ * * _ _ _ _ _ * * X X X X X * = X
11 |Twix 8 2018 _ * = * * X X X X X * = X

(In Excel) When complete, un-hide and/or un-freeze any columns. Click File > Save As. Re-name file and save
locally. Be sure the file type is .csv.

File name: gust 2018 - AF18 - Growini . w
Save as type: | CSV (Cormma delimited) (*.csv) e
Authors:  Andrea Latham Tags: Add atag Title:  Add a title

~ Hide Folders Tools - Cancel

191



On the Provider Portal, click the Upload button. A file manager window opens. Locate the saved file and click
Open.

® Bulk VPK Attendance

Download CSV file template, add child details, and click the Upload button. All files will be removed after 15 calendar days. Note: The MSID column is for public school use only. See the Provider Portal User Guide for more
infarmation

€ Open X
« © 4 > ThisPC > Desktop v @ | Search Deskiop p
o] v Mewfold -
Na records found e ewveier ~ ] o
A Name Date modified Type Size 2
s Quick access
2] August 2018 - AF18 - GrowingUpStreng.csv 11/29/20189:10PM  Microsoft Excel C... 3KB
‘@ OneDrive B:) Daisy Mae attendance 9-2018.csv 11/28/2018 1:06PM  Microsoft Excel C... 2KB
5 This pC {5 remaining rate changes.csv Microsoft Excel C... 247 KB
-] OELAdminDataFix 8-22-2013.csv Microsoft Excel C... 11 KB
I Desitop Y AN e e aaeanin D o v
File name: | August 2018 - AF12 - GrowingUpStrong.csv V‘ Microsoft Excel Comma Separa

The uploaded file displays in the Bulk VPK Attendance log.

@® Bulk VPK Attendance

Download CSV file template, add child details, and click the Upload button. Al files will be removed after 15 calendar days. Note: The MSID column is for public school use only. See the Provider Portal User Guide for more

information
le Total Records ‘Commited Records Failed Records Proces:
Status.
‘Count ‘Count ‘Count ime
2KB

Uploaded On | Document File Name inal
Type Results
11/29/2018 VPK Roster August 2018 - AF18 - null null null Submitted  Not
GrowingUpStrong.csv

Available

Click the Refresh button to get final results.

The successfully submitted attendance is now reflected on the class attendance roster. Each record shows "SUB"
for submitted.
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Attendance - SR

Providers manage SR attendance online by navigating to the Attendance menu item and selecting Manage SR
Attendance. Providers may submit their attendance through the web page. It is important to note that changes to
enrollment, such as entering a termination date, cannot be performed in the attendance module but rather the
Manage SR Enrollment area. Also, when issues appear on the attendance roster (such as incorrect enroliment
information, missing children, duplicate children, missing paid holidays, duplicate absences on the same day, etc.),
the issues should be communicated to the coalition before submitting the attendance roster. Coalitions may assist
in addressing the issues so that the attendance records have accurate information.

Submitting Attendance Online

Select the Manage SR Attendance menu item. The SR Attendance Roster displays, defaulting to the current
service period. The blue summary box to the right contains provider details and paid holiday information for the
service period.

NOTE: A service period is the month in which services were rendered. Child absences for the service period must
be marked, saved, and submitted to the coalition. A due date is displayed for each service period. Providers that
contract with multiple coalitions must submit an attendance roster to each coalition.

Children that are “Enrolled” are included on the SR attendance roster.
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New enrollments in “Pending Family Acceptance” will not be visible on attendance rosters and will only appear
once the family signs the payment certificate; however, there are exceptions.

e New enrollments for at-risk children (BG1) or at-risk children in relative care (BG3R) billing groups in
Pending Family Acceptance will populate on attendance rosters

e  Existing enrollments in Pending Family Acceptance that have already been submitted for attendance in
previous months will continue to populate on attendance rosters

If a provider has new enrollments in “Pending Family Acceptance”, when the provider clicks the Manage SR
Attendance menu item, a pop-up window will display with a count of those new enrollments and a link to the
Manage SR Enrollment queue.

See the Pending Family Acceptance Status section in this user guide for more information.
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The search feature may be used to search for any criteria included in the roster (i.e. a name, DOB, age, billing
group, or status). The summary feature shows the current/saved attendance information for all children in one

view.

To record attendance, click on a child’s name to view their attendance for the month.

o Days the site is closed are marked with an asterisk

“uxn

o Days the child is not scheduled to attend are marked with “NS”. If the entire month for a child is
marked “NS”, contact the local early learning coalition to correct the care days.
e Days the child is scheduled to attend are marked with an “X” for present along with his/her

scheduled unit of care

e Paid holidays where a child is also scheduled to attend are marked with an “H”
e Alegend is provided in the bottom right for more code descriptions

NOTE: The “Child’s Current Information” displayed on the right is current as of today. When working prior months,
the information displayed may not align. For example, if a child’s enrollment was terminated in February 2019, the
current enrollment status is Enrollment Ended. Each month (prior to February) will also display Enrollment Ended
in the “Child’s Current Information” area because it is the current enrollment status. This does not impact the
ability to record attendance for those prior months. Enhancements are planned to address the display.

With Release 6.0, the Person ID is now included in the “Child’s Current Information”:

Child's Current Information

Name

Person ID 3884229
DoB 9/19/2016 Age 6
Copay $0.02 BGrp BG8

Status Enrolled

Has Special Needs No

To change a present day to absent, click on the “X.” A pop-up message appears to collect more information.

a. Select an absent reason from the dropdown.
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LN

Include a message to the coalition regarding the absence in the Note area. (optional for most reasons)
Attach a file for supporting documentation by clicking Choose File. (optional)

Click Save when done and the pop-up message will close.

The “X” for present will now appear as an “A” for absent.
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f.  Consecutive absences can be entered by using a date range. A document can be attached to the absence
range and the document will be associated to every day entered in the date span.

g. Absences entered by mistake can be changed back to present by clicking on the “A.” The below pop-up
message appears. To undo the absence, click the Remove Absence button. That day will show an “X”, the
absence reason is removed, and the attachment is removed.

@ Indicate the child's attendance below. Supporting decumentation may be uploaded to the Document Management Library as needed.

Attendance Calendar

October 2021

Child's Current Information

Sun Mon Tue Wed Thu Fri Sat (e _
1 2 DoB  2/9/2018 Age 2
x »*
e ] Copay $2.15 BGrp BGS8
3 4 s 5 s Status Enrolled
* X A A A * Monthly Attendance Summary
D N
10 1 12 13 v, T 6 Anticipated Start Date  8/5/2021
* x x X X x * Absences
DETD ET AT e e
7 18 1o -0 51 P 25 10/05/2021  10/07/2021
* x x x X X - 10/06/2021
NETN ETN ET ET e
24 25 26 27 28 29 30 Days Absent 2
* x Days Present 14
- FT . .
Reimbursed Helidays o
31
Non-Reimbursable Days 0
RWA No

Schedule Note

N/A

Note:

X - Enrolled/Present — Allows Date Span Absence

A - Absent — Allows Date Span Absence

CR - Reimbursable Temporary Closure Day - Partial — Allows Date Span Absence

CN -Non-Reimbursable Temporary Closure Day — Partial — Allows Date Span Absence

N - Non-Reimbursable Day — Does Not Allow Date Span Absence

NS- Non-Scheduled Day — Does Not Allow Date Span Absence

.Paid Holiday — Does Not Allow Date Span Absence

T - Terminated/Enrollment Ended — Do Not Allow Date Span Absence

* Closed — Does Not Allow Date Span Absence

CR - Reimbursable Temporary Closure Day - Whole Site — Does Not Allow Date Span Absence

CN - Non-Reimbursable Temporary Closure Day - Whole Site — Does Not Allow Date Span Absence
Attendance has not started — Does Not Allow Date Span Absence
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While not required, it is recommended to click Save (below the calendar) before moving on to another child.
When all child absences are marked for the month, click Save and then click the Submit to Coalition button. A
window may appear if the attendance is being submitted early or late, or if no absences have been recorded. To
continue to the Sign & Certify page, click Continue.

N

The Sign and Certify page summarizes the information for each child and an electronic signature is required.
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Submitted Attendance

Upon submission, the screen returns to the SR Attendance Roster view with the current service period displayed.
Select the submitted service period from the drop down. The submitted roster now has a submitted message and
each child shows “SUB” for submitted in the status column. This status will change as the child attendance is
processed by the coalition.

Rejected Attendance

Coalition staff may reject submitted attendance. In this case, the individual that submitted the roster will receive
an email notification. Instructions are provided to log in to the Provider Services Portal, review the roster, make
necessary changes to rejected records, and re-submit. The rejected child records are displayed at the top of the
roster list in red and show "REJ" for rejected in the status column. Only records with "REJ" may be edited.
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To edit, click the name of a rejected record. Any absences previously recorded appear. Make changes as needed.
After the last record is corrected, click Save. Then, click the Submit to Coalition button and continue to the Sign &
Certify page. This time, the Sign & Certify page only shows the rejected records that are being re-submitted to the
coalition. Complete the Authorized Electronic Signature portion and click Submit.

Upon submission, the rejected "REJ" records appear on the roster as submitted "SUB."
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Approved Attendance

Coalition staff will continue to work submitted attendance until the records are approved for payment. Approved
records appear on the attendance roster as "APP" for approved in the status column.

When records are paid by the coalition, the reimbursement details are posted on the Provider Portal under
Attendance > Reimbursement Details.

Providers can run a Payment Period or Service Period Reimbursement Report.

Final Reimbursement Report

Report Name Action
Payment Period Report

Service Period Report Run Report

NOTE: These reports have been enhanced to include children who are dismissed to get the registration fee. A
dismissed child will show as $0.00 in the reports.
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Request for Registration Fee Payment

Registration Fee Payments can only be requested by a provider. To request a Registration Fee, navigate to
Enrollments > Manage SR Enrollments > Registration Fees > Eligible for Payment

Eligibility Rules for Registration Fee payments:

e Children are/were enrolled during the current program year.

e Children have not been paid more than 2 times in 5 years (or three with a hardship). Payments from 2019-
2020 are excluded.

e  Children with the BG1-ESS billing group and eligibility code are not eligible.

e Children “dismissed” by the provider for payment for the program year are not eligible.

e Children enrolled 3 months or less with expulsion reasons (Safety of Other Children or Behavior Problems)
are not eligible.

The Registration Fee Payments screen lists children who are eligible for Registration Fee payments. To request a
payment, check the checkboxes and click Request Payment button.
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On the Request Payment pop-up, check the | certify checkbox and click OK. The record will be available for the
coalition to Approve, Reject, or mark Ineligible.

Dismiss Children

If the provider has collected the registration fee from the family, the child is not eligible for a registration fee
payment. To dismiss children from the list of registration fee payments, check the checkbox and click Dismiss
Children button. Hovering over the Dismiss Children button will display the following message: “Remove all
selected children from this list and indicate that payment is not expected from the coalition.”
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The Dismiss Children pop-up window opens. Click the OK button to confirm dismissing the child(ren) from the list
of registration fee payments. The Provider won’t be able to resubmit these children for registration fee payment.
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SR Reimbursement Rate Plan

Providers can view their reimbursement rate plans in the Provider Portal. Navigate to Attendance > SR
Reimbursement Rates.

The Coalition dropdown shows all the coalitions the provider has a contract with. The Rate Plan Period dropdown
displays all the rate plans available based on the selected coalition. Clicking the Reimbursement Rates button will
navigate to the SR Reimbursement Rates screen.

5R Reimbursement Rates

Coalition: ELC of Palm Beach v

Rate Plan Period: 07/01/2022 - 12/31/2022

Reimbursement Rates
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After clicking Reimbursement Rates, the SR Reimbursement Rates show for the selected coalition and rate plan
period. The rates show the rates and differentials used to calculate reimbursement for the provider as shown in
Exhibit 5 of the contract. The provider can view the rates for different units of care by selecting an option from the

Unit of Care dropdown menu. Clicking the View Provider Rates button will navigate to the Provider’s Private Pay
Rates.

The rates are read-only. The rates in the Provider’s Pay Rates screen are the rates that display in Column A of the
SR Reimbursement Rates screen. Clicking the Back button will navigate to the SR Reimbursement Rates screen.
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From the SR Reimbursement Rates screen, clicking the View Differential Rates button will navigate to the
Provider’s Differential Rates screen. Clicking the Back button will navigate to the SR Reimbursement Rates screen.

From the SR Reimbursement Rates screen, clicking the Sample VPK Wrap Calculation link opens a pop-up with a
sample calculation. Clicking the Back button will navigate to the SR Reimbursement Rates screen.
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